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Aim and Objectives 

 Aim 

To illustrate how Excel and SPSS can be used 
to carry out statistical analysis and tests 

 Objectives 

To show you how to use some of the statistical 
worksheet functions available in Excel and 
SPSS 

To show you how to use some of the tools 
available in the Analysis ToolPak in Excel 
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Basic functions and 

statistical applications 

in Microsoft Excel 

Why use Excel? 

 Very popular and widely used 

 Software more accessible & user friendly 

 Easy to format output 

 Better charting facilities than some 

statistical applications 

 Good for exploratory/descriptive statistics 
 graphs and tables 
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In Life sciences and other fields, we 

will use Excel to: 

1. Store and organize data, 

2. Analyze data (descriptive statistics & 

inferential statistics), and 

3. Represent data graphically (e.g., in bar 

graphs, histograms, and scatter plots) 
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Starting MS Excel: 

 Starting MS Excel: Double click on the 

Microsoft Excel icon on the desktop  

or  

 Click on Start --> Programs --> Microsoft 

Excel. 
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Excel Basics 

This is a row.   

Rows are represented 

by numbers along the 

side of the sheet. 

This is a column.   

Columns are 

represented by letters 

across the top of the 

sheet. 

Excel spreadsheets organize information (text and 

numbers) by rows and columns: 
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Ribbon 

Font 
grouping 

Paragraph 
grouping 

Styles 
grouping 

 Home: has the common formatting tools, clipboard, fonts, 

paragraphs, number, Styles, Cells, and Editing. 
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Excel Basics 
• A cell is the intersection between a 

column and a row.   

 

• Each cell is named for the column letter 

and row number that intersect to make it. 

 

• For example, B2 is used to refer to the 

cell in column B and row 2. 

• B10:B20 is used to refer to the range 

of cells in column B and rows 10 

through 20. 
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Data Entry 
There are two ways to enter information into a cell: 

1. Type directly into the 
cell. 
Click on a cell, and type in 
the data (numbers or text) 
and press Enter. 

2. Type into the formula 
bar. 
Click on a cell, and then 
click in the formula bar (the 
space next to the      ).  Now 
type the data into the bar 
and press Enter. 
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Data Entry 
Enter the following information into your spreadsheet: 
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Formulas and Functions  

 Formulas are equations that perform 

calculations in your spreadsheet. Formulas 

always begin with an equals sign (=). When you 

enter an equals sign into a cell, you are basically 

telling Excel to ―calculate this.‖ 

 

 Functions are Excel-defined formulas. They take 

data you select and enter, perform calculations 

on them, and return value (s).  
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More on Functions 

 All functions have a common format – the equals sign 

followed by the function name followed by the input in 

parentheses. 

 The input for a function can be either: 

 A set of numbers (e.g., ―=AVERAGE(2, 3, 4, 5)‖) 

 This tells Excel to calculate the average of these numbers. 

 A reference to cell (s) (e.g., ―=AVERAGE(B1:B18) or 

―=AVERAGE (B1, B2, B3, B4, B5, B6, B7, B8)‖ 

 This tells Excel to calculate the average of the data that 

appear in all the cells from B1 to B8. 

 You can either type these cell references in by hand or by 

clicking and dragging with your mouse to select the cells.  
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Functions for Descriptive Statistics 

=AVERAGE(first cell:last cell): calculates the mean 

=MEDIAN(first cell:last cell): calculates the median 

=MODE(first cell:last cell): calculates the mode 

=VARP (first cell:last cell): calculates the variance 

=STDEVP(first cell:last cell): calculates the standard deviation 
 

 You may directly write the functions for these statistics into 

cells or the formula bar, OR 

 You may use the function wizard (       in the toolbar) 
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Functions for Descriptive Statistics 

 Your Excel 

spreadsheet 

should now look 

like this: 
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Advanced Microsoft Excel 2007 & 

2010 
 Click the Microsoft Office Button , and then click Excel 

Options.  

 Click Add-Ins, and then in the Manage box, select 

Excel Add-ins.  

 Click Go.  

 In the Add-Ins available box, select the Analysis 

ToolPak check box, and then click OK. 

 If you get prompted that the Analysis ToolPak is not 

currently installed on your computer, click Yes to install 

it.  

 After you load the Analysis ToolPak, the Data Analysis 

command is available in the Analysis group on the Data 

tab.  
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Descriptive Statistics and 

other Statistical methods in 

Excel  

 Descriptive Statistics and other 

Statistical methods : Tools  Data 

Analysis Statistical method.  
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Descriptive Statistics 

 Mean, Median, Mode 

 Standard Error 

 Standard Deviation 

 Sample Variance 

 

 Range 

 Minimum 

 Maximum 

 Sum 

 Count 

 kth Largest 

 kth Smallest 
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Descriptive Statistics and other 

Statistical methods in Excel 2010 
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Analysis ToolPak – in Excel 

 Descriptive Statistics 

 Correlation 

 Linear Regression 

 t-Tests 

 z-Tests 

 ANOVA 

 Covariance 
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Correlation and Regression 
 Correlation is a measure of the strength of linear association 

between two variables. 

 
 Every correlation has a direction (positive or negative): 

 + correlation: increase in one variable are associated with proportional 
increase with another variable.  
 Example: Length weight relation ship. Body height and weight 

 - correlation: increase in one variable are associated with decrease in 
other variable. 

 Values between -1 and +1 

 Values close to -1 indicate strong negative relationship 

 Values close to +1 indicate strong positive relationship 

 Values close to 0 indicate weak relationship. 

 

 Linear Regression is the process of finding a line of best fit through 
a series of data points. 
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Calculating Pearson‘s r 

 Correlations are described using the Pearson 
Product-Moment correlation statistic, or r value. 

 

 In Excel, there are many functions that can  calculate 
a correlation statistic, however, we will only use = 
PEARSON in this class. 

 

 Let‘s say we want to determine if there is a 
relationship between number of hours spent per 
week studying for SCBT 33112 Environmental 
biotechnology and GPA earned in the class at the 
end of the semester.  

 To do so, we can calculate Pearson‘s r for our two 
variables. 
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Enter the following data into Excel: 

Study Hrs = average number of hours spent per week studying for 

Environmental biotech 
 

GPA = grade-point average earned in Environmental biotech 26 
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Step 1: Select the cell where you want your r value to 

appear (you might want to label it). 

Step 2: Click on the function wizard      button. 

Step 3: Search for and select PEARSON. 
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Step 4: For Array1, select all the values under Study Hrs. 

    For Array2, select all the values under GPA. 
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Step 5: That‘s it! Once you have your r value, don‘t 

forget to round to 2 decimal places. 

Interpretation: What does the r value of 0.88 tell you about the 

strength and direction of the correlation between Study Hrs and 

GPA? 
29 

Create a Chart in Excel 2010 
 

To create a line chart, execute the following steps. 
 

1. Select the range A1:D7. 

 

2. On the Insert tab, in the Charts group, choose Line, and select 

Line with Markers. 
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Line graph 
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Change Chart Type 
 

You can easily change to a different type of chart at any time. 

 

1. Select the chart. 

 

2. On the Insert tab, in the Charts group, choose Column, and select 

Clustered Column. 
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Bar Chart - Species density in different 

months 

33 

Switch Row/Column 
If you want the animals, displayed on the vertical axis, to be displayed on the 

horizontal axis instead, execute the following steps. 

 

1. Select the chart. The Chart Tools contextual tab activates. 

2. On the Design tab, click Switch Row/Column. 

Bar Chart - Species density in 

different months 
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Add Chart Title 
 

To add a chart title, execute the following steps. 

 

1. Select the chart. The Chart Tools contextual tab activates. 

 

2. On the Layout tab, click Chart Title, Above Chart. 
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Legend Position 
By default, the legend appears to the right of the chart. To move the legend to the 

bottom of the chart,  

 

1. Select the chart. The Chart Tools contextual tab activates. 

 

2. On the Layout tab, click Legend, Show Legend at Bottom. 
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Creating two axis in a graph 

37 
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Adding Error Bars in Excel graph 

1. Select the chart. The 

Chart Tools contextual tab 

activates. 

2. On the Layout tab, click 

Error Bars, More Error 

Bars Options... 

3. Choose a Direction. Click 

Both. 

4. Choose an End Style. 

Click Cap. 

5. Click Fixed value and 

enter the value 10. 

 

42 



22 

If you have SD values select 

custom and specify the values 

by selecting reference cell 

43 

Other formatting 

functions in Excel 
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Insert a Row/Column 
 Insert a row: 

 Select the row you would like to insert above 

 Clicking on the row number tab. 

 In Home tab, go to Insert and select Insert Sheet Rows. 

 

 

 

 

 

 
 Insert a column: 

 Select the column you would like to insert next to it 

 Clicking on the column letter tab such as L. 

 In Home tab, go to Insert and select Insert Sheet Column. 
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Change Column Width or Row Height 

 Column Width 

 Drag the border between two columns to adjust 

a column width. 

 Adjust column width for a group of columns 

 Highlight the columns you want to adjust their width. 

 In Home tab, go to Format and select Column Width... 

 Enter a number of characters for column width. Click on 

OK. 

 Row Height 

 Drag the border between two rows to adjust a row width. 

 Adjust row width for a group of rows 

 Highlight the rows you would like to change their height. 

 In Home tab, go to Format and select Row Height.  

 Enter a number of the row height and click on OK. 

 One point=.035 cm 
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 Format a Worksheet 

 

 

 Change the font size, color, and the 

background of a cell or group of cells.  

 Select the cells you‘d like to change. Then 

select a formatting tool. 

 To show cell borders, highlight the cells 

and select a border.   
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Creating Basic Formula 
 You conduct a mathematical calculation in 

Excel by typing a simple formula into a 
cell. An Excel formula always begins with 
an equal sign (=).  

 Math operators 
 Addition: + 

 Subtraction:- 

 Multiplication:* 

 Division:/ 

 Example: Gas + Utilities 
 Click on the cell that displays the expense 

of Gas and Utilities. 

 Enter =. 

 Click on the Gas cell for January. 

 Enter +. 

 Click on the Utilities cell for January 

 Hit Enter key. 
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Copy a Formula 

 You may copy the same formula onto a series of 

cells. 
 Example, a total expense in each of all 12 months. 

 Select the total cell for January. 

 Drag the bottom right corner of the cell to expand to the 

December total cell. 

 The total expense is then calculated for all 12 months. 
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• Select the data for your table. 

• On the Home tab, in the Styles group, click the Format as Table button to display the 

Table Styles gallery. 

• Click the style you want to use for your table. 

• Excel will automatically populate the Format as Table dialog box with the selected data 

range. 

• Be sure to check the My table has headers check box if appropriate. 

• Click OK to create the table. 

Define Data as a Table 
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• On the Table Tools Design tab, in the Table Style Options group, 

click the Total Row check box. 

• In the Total row at the bottom of the table, click the column where 

you want to add a total. 

• Click the arrow, and select the function you want to use. 

To Add a Total Row to a Table 
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• Click any cell in the column to sort. 

• On the Home tab, in the Editing group, click 

the Sort & Filter button. 

• Click the sorting option you want. The 

sorting options change depending on the 

type of data in the column you are sorting 

by. 

• If the numbers in the column are 

formatted as dates, Excel detects this 

and offers sorting options Sort 

Oldest to Newest and Sort Newest 

to Oldest. 

• If the column contains text, the sort 

options are Sort A to Z and Sort Z to 

A. 

• If the column contains numbers, the 

sort options are Sort Smallest to 

Largest and Sort Largest to 

Smallest. 

To Sort the Data in Your Worksheet 
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Applying Conditional Formatting with 

Highlight Cells Rules 

 Conditional formatting with Highlight Cells Rules allows 

you to define formatting for cells that meet specific 

numerical or text criteria (e.g., greater than a specific 

value or containing a specific text string).  

 Use this type of conditional formatting when you want to 

highlight cells based on criteria you define. 
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• Select the data you want to apply 

conditional formatting to. 

• On the Home tab, in the Styles group, click 

the Conditional Formatting button. 

• From the menu, point to Highlight Cells 

Rules and click the option you want: 

• Greater Than . . . 

• Less Than . . . 

• Between . . . 

• Equal To . . . 

• Text That Contains . . . 

• A Date Occurring . . . 

• Duplicate Values . . . 

• Each option opens a dialog box where you 

can enter the condition to compare 

selected cells to and the formatting to 

apply when selected cells match the 

condition. 

• Click OK to apply the conditional 

formatting. 

To Highlight Cells with Conditional Formatting 
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• Select the cells you want to remove the 

formatting from. 

• On the Home tab, in the Styles group, 

click the Conditional Formatting button. 

• Point to Clear Rules, and click the option 

you want from the menu: 

• Clear Rules from Selected 

Cells 

• Clear Rules from Entire Sheet 

• Clear Rules from This Table 

(available if the selected cells are 

part of a table) 

To Remove Conditional Formatting 
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Applying Conditional Formatting with Top/Bottom 

Rules 

 One way to analyze worksheet data is to compare cell 

values to other cell values.  

 To highlight the highest or lowest values or values that 

are above or below the average, use conditional 

formatting Top/Bottom Rules.  

 When you use Top/Bottom Rules conditional formatting, 

Excel automatically finds the highest, lowest, and 

average values to compare values to, rather than asking 

you to enter criteria (as you do when using Highlight 

Cells Rules). 
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1. Select the data you want to apply 

conditional formatting to. 

2. On the Home tab, in the Styles group, 

click the Conditional Formatting 

button. 

3. From the menu, point to Top/ Bottom 

Rules and click the option: 

Top 10 Items . . . 

Top 10% . . . 

Bottom 10 Items . . . 

Bottom 10% . . . 

Above Average . . . 

Below Average . . . 

4. Each option opens a dialog box 

where you can modify the condition 

and select formatting to apply when 

cells match the condition. 

5. Click OK to apply the conditional 

formatting. 

To Highlight Cells with Conditional Formatting Top/Bottom 

Rules 
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1. Select the data you want to apply 

conditional formatting to. 

2. On the Home tab, in the Styles group, 

click the Conditional Formatting 

button. 

3. From the menu, point to one of the 

options, and then click the specific style 

of formatting you want. 

• Data Bars —Display a color bar (gradient 

or solid) representing the cell value in 

comparison to other values (cells with 

higher values have longer data bars). 

• Color Scales —Color the cells according 

to one of the color scales [e.g., red to 

green (bad/low to good/high) or blue to red 

(cold/low to hot/high)]. 

• Icon Sets —Display a graphic in the cell 

representing the cell value in relation to 

other values. 

Applying Conditional Formatting with Data Bars… 
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Generating Random 

numbers in Microsoft 

Excel 

Select a Random Decimal Value Between 0 

and 1 
 
If you want to generate a random decimal value between 0 and 

1, simply use the Excel Rand function in any cell of your 

worksheet: 

=RAND() 

 

This function will generate a different random decimal, between 

0 and 1 and every time your worksheet re calculates. 
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Select a Random Integer Between Two 

Supplied Integers 
 

The Excel Randbetween function is used to generate a random 

integer between two supplied integers. For example: 

=RANDBETWEEN(0, 10)  

=RANDBETWEEN(50, 75) 
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If you know the sampling frame in advance then you 

follow this 
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Statistics using SPSS 

What is SPSS? 
 Originally it is an acronym of Statistical Package 

for the Social Science but now it stands for 
Statistical Product and Service Solutions 

 SPSS is a powerful program which provides 
many ways to rapidly examine data and test 
scientific questions.  

 One of the most popular statistical packages 
which can perform highly complex data 
manipulation and analysis with simple 
instructions.  

 The program also is capable of producing high-
quality graphs and tables  
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Starting SPSS 
 Start → All Programs → IBM SPSS statistics 20  
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Data Editor 
 The Data Editor window displays the contents of the working dataset.  

 It is arranged in a spreadsheet format that contains variables in columns and 

cases in rows.  

 There are two sheets in the window.  

 The Data View is the sheet that is visible when you first open the Data 

Editor and contains the data.  

 The other one is Variable view 

66 
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Data  and Variable View 
Data View:  

 Allows you to entering the data and examine your 

actual data. 

Variable View:  

 Variable view is for Naming and define the 

variables 

 Is it a string or numeric variable?  

 Are there labels for it? In Variable view, you can 

add labels to variables so your results will be 

easier to understand. 
67 

Variable View window & Defining variable 

names and their properties in SPSS 

 This sheet contains information about the data set that is 

stored with the dataset 

 Name of the variable 

 Type  

 Width 

 Decimal  

 Label  

 Values  

 Missing 

 column  

 Align  

 Measure 

68 
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Name 

 The first character of the variable name 

must be alphabetic 

 Variable names must be unique, and have 

to be less than 64 characters.  

 Spaces are NOT allowed. 
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Variable View window: Type 
 Click on the ‗type‘ box.  

 The two basic types of variables that you will use are numeric 

and string. This column enables you to specify the type of 

variable. 
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Variable View window: Width 

Width allows you to determine the number of 
characters SPSS will allow to be entered for the 
variable 
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Variable View window: Decimals 

 Number of decimals 

 It has to be less than or equal to 16 

3.14159265
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Variable View window: Label 

 You can specify the details of the variable 
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Variable View window: Values 

This is used and to suggest which numbers represent 

which categories when the variable represents a 

category  

 

Male 1; Female 2 

Treatment group 1; Control group 2 74 
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Defining the value labels 

 Click the cell in the values column as shown below 

 Value 1 for male and 2 for female and then click OK 

Click 
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Columns 

 The columns property tells SPSS how wide the 
column should be for each variable.  

 

 Don't confuse this one with width, which indicates 
how many digits of the number will be displayed. 
The column size indicates how much space is 
allocated 

Align 

 The alignment property indicates whether the 
information in the Data View should be left-
justified, right-justified, or centered 
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Missing Values for a Numeric Variable 
 Survey respondents may refuse to answer certain 

questions, may not know the answer.  

 If you don't filter or identify these data, your 

analysis may not provide accurate results. 
1. Click the Variable View tab at the bottom of the Data Editor 

window. 

2.  Click the Missing cell in the row, and then click the button on the 

right side of the cell to open the Missing Values dialog box. In this 

dialog box, you can specify up to three distinct missing values, or 

you can specify a range of values plus one additional discrete 

value. 

3. Select Discrete missing values. 

4. Type 999 in the first text box and leave the other two text boxes 

empty. 

5. Click OK to save your changes and return to the Data Editor. Now 

that the missing data value has been added, a label can be 

applied to that value. 

6. Click the Values cell in the age row, and then click the button on 

the right side of the cell to open the Value Labels dialog box. 

7. Type 999 in the Value field. 

8. Type No Response in the Label field. 

9. Click Add to add this label to your data file. 

10. Click OK to save your changes and return to the Data Editor. 77 

Measure 

  The Measure property indicates the level of 
measurement.  

 Since SPSS does not differentiate between 
interval and ratio levels of measurement, both of 
these quantitative variable types are lumped 
together as "scale".  

 

 Nominal and ordinal levels of measurement, 
however, are differentiated 
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SPSS Viewer 

 All output from statistical analyses and 

graphs is displayed to the SPSS Viewer 

window.  
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How to access data into SPSS from your computer - Opening 

an Excel file  

1. Go to “File” then “Open” and click on “Data” 
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2. Be sure that the “Files of type” is set on Excel (*.xls) 

3. Click on the Excel File you want to open. 

4. Either Double-Click the file name or click the “Open” button 

 81 

5. Choose the name of the worksheet that your data is in.  (You can only 

choose one worksheet at a time) 

6. Click “OK” 
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If you look at the bottom left, you‘ll see tabs for Data View and Variable 

View 
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To view value Labels 
 

You can use the Value Labels 

button on the toolbar 

Descriptive value labels are 

now displayed to make it easier 

to interpret the responses 
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Running Analysis in 

SPSS 

Practice 1 

 How would you put the following information into SPSS? 

Value = 1 represents Male and Value = 2 represents Female 

Name Gender Height

JAUNITA 2 5.4

SALLY 2 5.3

DONNA 2 5.6

SABRINA 2 5.7

JOHN 1 5.7

MARK 1 6

ERIC 1 6.4

BRUCE 1 5.9
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Practice 1 (Solution Sample) 

Click  
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Variable View and Data View window  

 The Data View window 

 This sheet is visible when you first open the Data Editor and this 

sheet contains the data 

 Click on the tab labeled Variable View  
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Click  

Sorting the data 

89 

Sorting the data 

 Click „Data‟ and then click Sort Cases 
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Sorting the data 
 Double Click ‗Name of the students.‘  

 Then click ok. 

Click 

Click 
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Practice 2 

 How would you sort the data by the ‗Height‘ of 

students in descending order? 

 Click data, sort cases, double click ‗height of 

students,‘ click „descending,‘ and finally click ok. 
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Recoding Variables in 

SPSS 

Recoding 

 You can use recoding to produce different 

values or codes for a variable. Recoding 

can be done in one of two ways: 

Recoding into the same variable 

Recoding into a different variable 
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Recoding 

 There are 3 main types of recoding: 

Recode single values 

Recode a given range of values 

Recode data into two categories 
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Recode single values in SPSS 

 
Example: The data given below represents 

cricket run scored by 5 Batsmen in a match. 

We can recode the batsman with the highest 

runs given a code of "1" and the batsman 

with the lowest runs given a "5". 

  Number of runs by batsmen 

Batsmen 1 2 3 4 5 

Runs 86 120 56 10 18 
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Click on Transform > Recode Into 

Different Variables. 
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 C 

99 

 

100 



51 

Recode a given range 

 
Example: You are provided with marks of 10 

students in a final business statistics 

examination.  

You can recode the data by giving code "1" 

to scores between 75 - 100, code 2 to scores 

between 61 - 74, code 3 to scores between 

41 - 60 and code 4 to scores between 0 - 40. 

Final examination scores of 10 students 

Scores 58 86 74 70 79 60 35 42 55 91 
101 

 Click on Transform > 

Recode Into 

Different Variables 

102 
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Recoding data into categories 

 Example: The data represents a customer 

satisfaction rating out of 10 for a new 

service offered by a company.  

The company would like to code all those 

who responded by giving ratings above 5 a 

"Satisfactory" code and those below 5 a 

"Dissatisfactory" code. 

Satisfaction scores for a new service 

Scores 3 6 8 9 7 2 10 6 4 8 9 3 

105 

 Click on Transform > 

Recode Into Different 

Variable 

Name the output variable of "NRatings" 

and label of "New Ratings" 
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Enter the value of "5" into the Range, 

LOWEST through value: in the -Old 

Value- area, and set the new code to 

Dissatisfactory into the Value in the -

New Value- area.  

Click the Output 

variables are strings 

107 

Computing New 

Variables using SPSS 
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Computing a New Variable 
 You may need to compute a new variable 

based on existing information (from other 

variables) in your data. 

 Example: 

You may want to convert the units of a 

variable from feet to meters, or use a subject's 

height and weight to compute their BMI. 

Example: 

How to calculate Gonado somatic index (GSI) 

of fish from a given data of [Ovary 

weight/body weight*100] 
109 

Compute GSI 
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Computing a New Variable 

(GSI) 

 To compute a new variable, click 

Transform > Compute Variable. 
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Z score compute 

using SPSS 



58 

Z-Scores tell us whether a particular score is equal to the mean, below the 

mean or above the mean of a bunch of scores. They can also tell us how far a 

particular score is away from the mean. Is a particular score close to the mean 

or far away? 

 

 If a Z-Score…. 

 

 Has a value of 0, it is equal to the group mean. 

 

 Is positive, it is above the group mean. 

 

 Is negative, it is below the group mean. 

 

 Is equal to +1, it is 1 Standard Deviation above the mean. 

 

 Is equal to +2, it is 2 Standard Deviations above the mean. 

 

 Is equal to -1, it is 1 Standard Deviation below the mean. 

 

 Is equal to -2, it is 2 Standard Deviations below the mean. 

Z score  
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In the Data View of the Data Editor 

window, the z-scores will be added 

as a new variable (Ztotallength and 

Ztotalweight) with each individual 

case having a z-score. 
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Descriptive Statistics  

using SPSS 

Descriptive analysis 

 Descriptive statistics are commonly used 

for summarizing data frequency or 

measures of central tendency (mean, 

median and mode).  

 If your data is categorical, use the 

frequencies or crosstabs procedures. 

  If your data is scale level, use 

summaries or descriptives. 
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Frequency Analysis  

using SPSS 

Frequency analysis is a descriptive statistical method that 

shows the number of occurrences of each and each category of 

variables and  response chosen by the respondents. 

Consider the following variables  

 Program 

 Gender 

 Year of study 

 

Frequency analysis  
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From the menus choose: 

Analyze > Descriptive Statistics > Frequencies... 

 

121 

Select and place the demographic variables  

• Click Program, Gender, year of study and drag the variable into the target 

Variable(s) list. 
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123 

• No missing values 

in the data set 

• Programme, 

Gender, year of 

study distribution 

(frequency and 

percent) 
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Copy and paste all graphs to Excel file as follows in two rows 
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Copy all the chart from excel and paste special  and then choose 

– bitmap in word as follows 

127 

Give Figure title and Figure number 

C 

A 

D 

B 

Fig 1. Demographic details of the participants 
128 



65 

If you want to rearrange the column and row items, 

Try Pivot Table.. Select the table – Right click – 

Edit Content – In Viewer. 
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130 



66 

Edit and formatting table 

• Copy table from SPSS Output 

• Paste in excel file 

• Clear formatting as follows 

• Delete unwanted columns 
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Select the table and auto format in word 
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APA (American Psychological Association) style formatting 

table 

 

Age of the participants Frequency Percent 

20-30 64 32.0 

31-40 yrs 35 17.5 

41-50 yrs 43 21.5 

51-60 yrs 27 13.5 

> 60 yrs 31 15.5 

Total 200 100.0 
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Creating a Bar Chart 

using SPSS 

Bar chart 

 A bar chart is helpful in graphically 

describing (visualizing) your data. It will 

often be used in addition to inferential 

statistics.  

 For example, a bar chart can be 

appropriate if you are analysing your data 

using an independent-samples t-test, 

paired-samples t-test (dependent t-test), 

one-way ANOVA or repeated measures 

ANOVA 136 



69 

Example 

  The concentration of cholesterol (a type of fat) in the blood is associated with the risk of 

developing heart disease, such that higher concentrations of cholesterol indicate a higher 

level of risk and lower concentrations indicate a lower level of risk. If you lower the 

concentration of cholesterol in the blood, your risk for developing heart disease can be 

reduced. Being overweight and/or physically inactive increases the concentration of 

cholesterol in your blood. Both exercise and weight loss can reduce cholesterol 

concentration. However, it is not known whether exercise or weight loss is best for 

lowering blood cholesterol concentration. 

A random sample of inactive male individuals that were classified as overweight were recruited 

to investigate whether an exercise or weight loss intervention is more effective in lowering 

cholesterol levels. This sample was split into two groups: one group underwent an "exercise 

training programme" (labelled "exercise" in the bar chart), and the other group undertook a 

"calorie-controlled diet" (lablled "diet" in the bar chart). In order to determine which treatment 

programme was more effective, the mean cholesterol concentrations were compared between 

the two groups at the end of the treatment programmes. The dependent variable was 

Cholesterol Concentration, and the independent variable, Treatment, which consisted of 

these two groups: "exercise" and "diet" 
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Creating a Bar Chart using 

SPSS 

 Click Graphs > Chart Builder... on the 

top menu as shown below: 
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Under the Gallery Tab (Gallery), select the Bar option and the simple bar chart icon (top-left icon). 

Drag-and-drop this icon into the Chart Preview Area.  

139 

You will be presented with the following dialog boxes: Chart Builder and 

Element Properties. You can see, the Chart Preview Area with simple bar 

chart. 
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Transfer the independent variable, Treatment, into the "X-Axis?" box and the dependent 

(outcome) variable, Cholesterol Concentration, into the "Y-Axis?" box within the Preview 

Chart Area by drag-and-dropping the variables from the Variables: box. 

141 

Ideally, we want to be able to show a measure of the spread of the data. In this case, we wish to have 

error bars that represent ± 1 standard deviations. To do this, we tick the Dispay error bars checkbox 

and then, under the -Error Bars Represent- area, we check the Standard deviation box, and in the 

Multiplier:, enter "1". 

Click apply 
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 We want to change the y-axis label so that we can remove the 

"mean" text and add in some units of measurement. We do this by 

selecting "Y-Axis (Bar1)" in the Edit Properties of: box and then 

change the Axis Label: as below: 
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Summary Measures for 

Scale Variables using 

SPSS 
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Descriptive statistics: Summary Measures 
 

A study was conducted to determine the serum cholesterol (mmol/L) 

measured on a sample of 86 stroke patients and the results are given in 

the below table. 

 
3.7  4.8  5.4  5.6  6.1  6.4  7.0  7.6  8.7  

3.8  4.9  5.4  5.6  6.1  6.5  7.0  7.6  8.9  

3.8  4.9  5.5  5.7  6.1  6.5  7.1  7.6  9.3  

4.4  4.9  5.5  5.7  6.2  6.6  7.1  7.7  9.5  

4.5  5.0  5.5  5.7  6.3  6.7  7.2  7.8  10.2  

4.5  5.1  5.6  5.8  6.3  6.7  7.3  7.8  10.4  

4.5  5.1  5.6  5.8  6.4  6.8  7.4  7.8  
 

4.7  5.2  5.6  5.9  6.4  6.8  7.4  8.2  
 

4.7  5.3  5.6  6.0  6.4  7.0  7.5  8.3  
 

4.8  5.3  5.6  6.1  6.4  7.0  7.5  8.6  
 

 

147 

Descriptive Statistics 

Descriptive measures describe the 

properties, distribution, dispersion and 

pattern of data  
 Mean – Gives central value  

 Median – Gives middle number  

 Mode – Gives high frequency number 

 Standard deviation with upper and lower limits to mean  

 Skewness and Kurtosis – Give the nature of frequency 

curve 

 Maximum and Minimum gives the range of values 
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• Enter the data 

• Click ANALYZE – Descriptive statistics 
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Interpretation of descriptive measures 

 Mean value is used for comparison 

 Mean is not a good measure as it could be 

affected by extreme values  

 Hence median (the middlemost number) in a 

series is considered instead of mean 

 Mode is the very frequently occurring item, like 

frequent selling item 
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 Standard deviation (SD) is the distance measure 

from mean. Normally denoted by σ. 

 SD is useful in deciding confidence intervals 

 In combination with mean the SD decides the 

probabilities in normal (Gaussian) distributions 

 (1σ to -1σ) cover 68% of area in a normal curve  

 (2σ to -2σ) cover 96% of area in a normal curve 

 (3σ to -3σ) cover 99.9% of area in a normal curve 

 

Interpretation of descriptive measures 
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Skewness and Kurtosis results Interpretation 

 Skewness value 0 is considered normal 

 Skewness between -1 to +1 considered normal and 

requires no transformation of data 

 Beyond -1 to +1 in either direction requires transformation 

of data to do any further analysis 

 Transformation may be in the form of LN (natural log) or 

square or square root etc 

 If the data do not become normal even after 

transformation, then NON-PARAMETRIC analysis is to be 

applied. 

 Kurtosis between -1 to +1 considered normal and requires 

no transformation of data 

 Beyond -1 to +1 in either direction requires transformation 

of data to do any further analysis 155 

Testing for Normality 

using SPSS  
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 The concept of normality is central to 
statistics. Normality refers to the 
„shape‟ of the distribution of data. 
Consider a histogram of values for one 
variable.  

 By drawing a line across the ‗tops‘ of 
the bars in the histogram, we are able 
to see the ‗shape‘ of the data.  

 When the „shape‟ forms a „bell‟ 
shape, we generally call this a 
normal curve.  

 The figure is approximately normally 
distributed. 

 For data to be normal, they must have 

the form of a bell curve  

 

Normality 
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Assessing Normality Visually and Statistically 
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Statistical Approach Visual Approach 

159 

Statistical Approach 

A positive skewness value indicates positive (right) skew; a negative 

value indicates negative (left) skew. 

Skewness and kurtosis values between –1.0 and +1.0 is 

considered normal  
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Visual Approach:   
Frequency Distributions 

161 

Click Analyze > Descriptive Statistics > Explore... on the top menu, as 

shown below: 

Normality  Checking different levels of independent variable 

162 
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You will be presented with the Explore dialogue box, as shown below: 

Transfer the variable that needs to be 

tested for normality into the Dependent 

List:  

Transfer the Time variable into the 

Dependent List: box.  

163 

[Optional] If you need to establish if your variable is normally distributed for 

each level of your independent variable, you need to add your independent 

variable to the Factor List: box  

In this example, we transfer the Course variable into the Factor List: box.  

You will be presented with the following screen: 

Click the Statistics Button.  
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Click the SPSS Plots Button.  

 

Change the options so that you 

are presented with this screen: 

Check descriptives 
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Shapiro-Wilk Test of Normality 

The above table presents the results from two well-known tests of normality, 

namely the Kolmogorov-Smirnov Test and the Shapiro-Wilk Test.  

 

We can see from the above table that for the "Beginner", "Intermediate" and 

"Advanced" Course Group and the dependent variable, "Time", was normally 

distributed.  

 

If the Sig. value of the Shapiro-Wilk Test is greater than 0.05, the data is 

normal. If it is below 0.05, the data significantly deviate from a normal 

distribution. 
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• Kolmogorov-Smirnov D test is a test of normality for large samples.  

• This test is similar to a chi-square test for goodness-of-fit, testing to 

see if the observed data fit a normal distribution.  

• If the results are significant, then the null hypothesis of no difference 

between the observed data distribution and a normal distribution is 

rejected 

Kolmogorov-Smirnov D test 

Shapiro-Wilks W test is considered by some authors to be the best test of 

normality (Zar 1999). Shapiro-Wilks W is limited to "small" data sets up to 

n = 2000. 

Shapiro-Wilks W test  
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Homogeneity of Variance - 

Levene's Test  

 
For parametric statistics to work optimally, 

the variance of the data must be the same 

throughout the data set.  

This is known as homogeneity of variance, 

and the opposite condition is known as 

heteroscedasticity. 
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Levene's Test  "Sig." value is higher than 0.05), the two variances are similar and 

not rejecting the null hypothesis, and you can proceed to use a parametric test. 
170 
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Student t -  tests 

using SPSS 

t test 
 One-sample t-tests: 

 Used to compare one sample mean to a population mean or some other 
known value. 

 Average birth weight of new born baby 

 You hear that the average person sleeps 8 hours a day. You think college 
students sleep less. You ask 100 college students how long they sleep on an 
average a day.  

 You get the data and the mean of sleeping hrs is 6.5 hours.  

 

Compare two (or more) sample means to each other 

 

Two general research strategies:  

 

 Two completely separate (independent) samples 

 Example: Hemoglobin levels in male and female is same or not? 

 Body fat content in pig fed with two different diets 

 

 Two related (dependent) samples 

 measure the size of tumor for cancer patient's before and after a treatment 
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Report p values as being less than .05, .01, or .001. 
 
If a result is not significant, report p as being  
greater than .05 (p > .05) 

if p = .017 report p < .05 We conclude that group means are significantly 
different 

if p = .005 report p < .01 We conclude that group means are significantly 
different 

If p = .24 report p > .05 We conclude that group means are NOT 
significantly different 

Here are some examples… 

Reporting Significance 

173 

One sample t 

tests using SPSS 
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One-Sample t Test SPSS 

 Tests for difference between sample mean and 
pre-determined population mean. 

 Compares the mean score of a sample to a known value. 
Usually, the known value is a population mean.  

 Examples:  
 Comparison of mean dietary intake of a particular group of 

individuals with the recommended daily intake. 

 Average birth weight of new born baby in Malaysia 

 Blood pressure  and glucose is normal in adults 

 

 Hypotheses: 
 Null: There is no significant difference between the sample mean 

and the population mean. 
Alternate: There is a significant difference between the sample 
mean and the population mean. 
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Assumption #1: Your dependent variable should be measured at the 

interval or ratio level (i.e., continuous).  

 

Assumption #2: The data are independent (i.e., not correlated/related), 

which means that there is no relationship between the observations.  

 

Assumption #3: There should be no significant outliers.  

 

Assumption #4: Your dependent variable should be approximately 

normally distributed.  

 

One-Sample t Test 
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Example of study 

 A researcher is planning a psychological intervention study, but 

before he proceeds he wants to characterize his participants' 

depression levels.  

 He tests each participant on a particular depression index, where 

anyone who achieves a score of 4.0 is deemed to have 'normal' 

levels of depression. Lower scores indicate less depression and 

higher scores indicate greater depression. The study included 40 

participants. Depression scores are recorded in the variable 

dep_score. He wants to know whether his sample is representative 

of the normal population (i.e., do they score statistically 

significantly differently from 4.0). 
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One-Sample t Test SPSS 

Click ―Analyze‖  ―Compare Means‖ 

 ―One- Sample T Test…‖ 

―Test Value‖ = Predetermined 

population mean 

EXAMPLE: 

  Compared the mean depression score of 4.0 a 

known population value of 4 
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Enter the dependent variable, dep_score, (depression score). 

 

179 

You will be presented with the One-Sample T Test 

dialogue box, as shown below: 
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 Transfer the dependent variable, dep_score, into the Test 

Variable(s): box  

 Enter the population mean you are comparing the sample against in 

the Test Value: box, by changing the current value of "0" to "4".  

Click on the  options button.  

You will be presented with the One-Sample 

T Test: Options dialogue box 

 

Click the  continue button.  

 

Then click the  OK  to 

generate the output. 

 

181 

Interpreting the SPSS output of the one-sample 

t-test 

 

 

Mean depression score (3.72 ± 0.74) was 

lower than the population 'normal' 

depression score of 4.0. 
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One-sample t-test 

 
 

 

 

Interpretation:  
You are presented with the observed t-value ("t" column), the degrees of freedom ("df"), and 

the statistical significance (p-value) ("Sig. (2-tailed)".  

In this example, p < .05 (it is p = .022).  

 

Therefore, it can be concluded that the population means are statistically significantly 

different.  

 

If p > .05, the difference between the sample-estimated population mean and the 

comparison population mean would not be statistically significantly different. 
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Writing in the manuscript 

 A one-sample t-test was run to determine whether 

depression score in recruited subjects was different to 

normal, defined as a depression score of 4.0.  

 

 Mean depression score (3.73 ± 0.74) was lower than the 

normal depression score of 4.0, a statistically significant 

difference of 0.28 (95% CI, 0.04 to 0.51), t(39) = -2.831, 

p = .022. 
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Paired Samples t 

Test using SPSS 

Paired Samples t Test 

 Tests if two related samples differ 
significantly from one another 

 Same individuals are studied more than 
once in different time. 

 
Measurement made on the sample people 

before and after. 

Example:  To evaluate the effect of new diet on 
weight loss. 

  Cholesterol levels before and after drug 
administration for a group of people 
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Hypothesis: 
 Null: There is no significant difference between 

the means of the two variables. 

 

 Alternate: There is a significant difference 

between the means of the two variables. 

 

Example SPSS output:  

 Compare the mean test scores before (pre-test) and after 

(post-test) the subjects completed a test preparation 

course.  

 We want to see if test preparation course improved 

people's score on the test.  

187 

Example 

 
 A group of Sports Science students (n = 20) are selected 

from the population to investigate whether a 12-week 

plyometric-training programme improves their standing 

long jump performance.  

 In order to test whether this training improves 

performance, the students are tested for their long jump 

performance before they undertake a plyometric-training 

programme and then again at the end of the programme 

(i.e., the dependent variable is "standing long jump 

performance", and the two related groups are the 

standing long jump values "before" and "after" the 12-

week plyometric-training programme). 

 188 
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Click Analyze > Compare Means > Paired-Samples T Test... on the 

top menu, as shown below: 
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 Transfer the variables JUMP1 and JUMP2 into the Paired Variables: box.  

 Click on the options button. 
190 
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 You will be returned to the Paired-

Samples T Test dialogue box. 

 Click OK button. 

 

Click the continue 

191 

Output of the Dependent T-Test in SPSS 

 

 

 
 

Reporting the Output of the Dependent T-Test 

 

You might report the statistics in the following format: t(degrees of freedom) = t-

value, p = significance level. In our case this would be: t(19) = -4.773, p < 0.0005. 

Due to the means of the two jumps and the direction of the t-value, we can 

conclude that there was a statistically significant improvement in jump distance 

following the plyometric-training programme from 2.48 ± 0.16 m to 2.52 ± 0.16 m 

(p < 0.0005); an improvement of 0.03 ± 0.03 m. 
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Two Samples 

independent t Test 

using SPSS 

Independent-Samples t Test 

Compares the means between two unrelated 
groups on the same continuous, dependent 
variable.  

 

 Example: To study the weight gain of fish fed with low 
and high protein fed groups. 

 

 Example: First year graduate salaries differed based on 
gender (i.e., dependent variable would be "first year 
graduate salaries" and independent variable would be 
"gender", which has two groups: "male" and "female").  
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Independent Sample Data (Data are 

time off task) 

Experimental (Caff) Control (No Caffeine) 
12 21 

14 18 

10 14 

8 20 

16 11 

5 19 

3 8 

9 12 

11 13 

15 

N1=9, M1=9.778, SD1=4.1164 N2=10, M2=15.1, SD2=4.2805 
195 

Study Example 

 • The concentration of cholesterol in the blood is associated with the risk of 

developing heart disease, such that higher concentrations of cholesterol indicate a 

higher level of risk, and lower concentrations indicate a lower level of risk. 

• If you lower the concentration of cholesterol in the blood, your risk of developing 

heart disease can be reduced. Being overweight and/or physically inactive 

increases the concentration of cholesterol in your blood.  

• Both exercise and weight loss can reduce cholesterol concentration. 

However, it is not known whether exercise or weight loss is best for lowering 

cholesterol concentration.  

• Investigated whether an exercise or weight loss intervention is more effective in 

lowering cholesterol levels.  

• The researcher recruited a random sample of inactive males that were classified 

as overweight.  

• This sample was then randomly split into two groups:  

• Group 1 underwent a calorie-controlled diet and 

• Group 2 undertook the exercise-training programme.  

• In order to determine which treatment programme was more effective, the mean 

cholesterol concentrations were compared between the two groups at the 

end of the treatment programmes. 
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Test Procedure in SPSS 

 Click Analyze > Compare Means > Independent-

Samples T Test... on the top menu, as shown below: 
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You will be presented with the Independent-Samples T 

Test dialogue box, as shown below: 

 

 

 

 

 
 Transfer the dependent variable, Cholesterol, into the Test 

Variable(s): box, and transfer the independent variable, Treatment, 

into the Grouping Variable box 
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You then need to define the groups (treatments). Click on the Define 

Groups button.  

You will be presented with the Define Groups dialogue box, as shown 

below: 

 

 

 

 
 Enter 1 into the Group 1: box and enter 2 into the Group 2: box.  

 Remember that we labelled the Diet Treatment group as 1 and the 

Exercise Treatment group as 2. 
 Click the continue 
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 Click the continue button.  

 You will be returned to the Independent-

Samples T Test dialogue box. 

 Click the Ok button. 
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Group means are significantly different because the value in the "Sig. (2-tailed)" row is less than 0.05. 

 

Interpretation: 

 
This study found that significantly lower cholesterol concentrations (5.80 ± 0.38 mmol/L) at the end of an 

exercise-training programme compared to after a calorie-controlled diet (6.15 ± 0.52 mmol/L), t(38) = 2.428, p 

= 0.020. 

 
201 

One-way analysis of 

variance (ANOVA)using 

SPSS 
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One-way analysis of variance 

(ANOVA) 

 The one-way analysis of variance (ANOVA) is used to 

determine whether there are any significant differences 

between the means of three or more independent 

(unrelated) groups.  

 

 For example, you could use a one-way ANOVA to understand 

whether exam performance differed based on test anxiety 

levels amongst students, dividing students into three 

independent groups (e.g., low, medium and high-stressed 

students).  

203 

Assumptions 

  Assumption #1: Your dependent variable should be measured at the 

interval or ratio level (i.e., they are continuous).  

 Examples of variables that meet this criterion include revision time (measured in 

hours), intelligence (measured using IQ score), exam performance (measured from 

0 to 100), weight (measured in kg).  

 Assumption #2: Your independent variable should consist of two or 

more categorical, independent groups 

 Assumption #3: You should have independence of observations, 

which means that there is no relationship between the observations in 

each group or between the groups themselves.  

 Assumption #4: There should be no significant outliers.  

 Assumption #5: Your dependent variable should be approximately 

normally distributed for each category of the independent 

variable.  
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Example 

  A manager wants to raise the productivity at his company by 

increasing the speed at which his employees can use a particular 

spreadsheet program. As he does not have the skills in-house, he 

employs an external agency which provides training in this 

spreadsheet program.  

 They offer 3 courses: a beginner, intermediate and advanced 

course. He is not sure which course is needed for the type of work 

they do at his company, so he sends 10 employees on the beginner 

course, 10 on the intermediate and 10 on the advanced course. 

When they all return from the training, he gives them a problem to 

solve using the spreadsheet program, and times how long it takes 

them to complete the problem. He then compares the three courses 

(beginner, intermediate, advanced) to see if there are any 

differences in the average time it took to complete the problem. 
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 SPSS procedure Analysis, Compare Means, One-Way 
ANOVA 

 

 Dependent List is for variable for which means are to be 
calculated, compared. 

 

 Factor is for variable used to designate the different 
samples or groups 

 

 Options to specify Descriptive Statistics 

 Post Hoc for multiple comparisons 
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Steps 

 In SPSS, enter the groups for analysis by 

creating a grouping variable called Course 

(i.e., the independent variable), and give 

the beginners course a value of "1", the 

intermediate course a value of "2" and the 

advanced course a value of "3".  

 Time to complete the set problem was 

entered under the variable name Time 

(i.e., the dependent variable). 
207 

Click Analyze > Compare Means > One-Way ANOVA... on the top 

menu as shown below. 
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Transfer the dependent variable (Time) into the Dependent List: box 

and the independent variable (Course) into the Factor: 

Click the post hoc button.  
209 

Tick the Tukey checkbox as shown below: 

 

 

 

 

 

 

 Click the continue button. 
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Click the options button. Tick the Descriptive checkbox in the –

Statistics– area, as shown below: 

 

 

 

 

 

 

 Click the continue button. 

 Click the OK button. 
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Descriptives table 

 

 

 

 
The descriptives table provides some very useful descriptive statistics, including the mean, 

standard deviation for the dependent variable (Time) for each separate group 

(Beginners, Intermediate and Advanced). 
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 Statistically significant difference between our group means. We can 

see that the significance level is 0.021 (p = .021), which is below 

0.05. and, therefore, there is a statistically significant difference 

in the mean length of time to complete the spreadsheet problem 

between the different courses taken. 
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 Multiple Comparisons, shows that, there is a significant difference in time to 

complete the problem between the group that took the beginner course 

and the intermediate course (p = 0.046), as well as between the beginner 

course and advanced course (p = 0.034).  

 There were no differences between the groups that took the 

intermediate and advanced course (p = 0.989). 
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Interpretation and reporting 

 

 

 

 

 

 

 

There was a statistically significant difference between groups as determined by 

one-way ANOVA (F(2,27) = 4.467, p = .021). A Tukey post hoc test revealed that 

the time to complete the problem was statistically significantly lower after taking the 

intermediate (23.6 ± 3.3 min, p = .046) and advanced (23.4 ± 3.2 min, p = .034) 

course compared to the beginners course (27.2 ± 3.0 min). There were no 

statistically significant differences between the intermediate and advanced groups  

(p = .989). 
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Example 

Treatment 1 

 

Treatment 2 

 

Treatment 3 

 

Treatment 4 

 
60 g 

 

50 

 

48 

 

47 

 
67 

 

52 

 

49 

 

67 

 
42 

 

43 

 

50 

 

54 

 
67 

 

67 

 

55 

 

67 

 
56 

 

67 

 

56 

 

68 

 
62 

 

59 

 

61 

 

65 

 
64 

 

67 

 

61 

 

65 

 
59 

 

64 

 

60 

 

56 

 
72 

 

63 
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Effect of dietary protein levels on final body weight (g) of catfish fed for 30 days 

T1- 30% protein; T2 – 35%, T3 – 40%; T4-45%. 
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Two-way analysis of 

variance (ANOVA)using 

SPSS 

Two-way ANOVA in SPSS  

The two-way ANOVA compares the mean differences 

between groups that have been split on two 

independent variables (called factors).  

 

The primary purpose of a two-way ANOVA is to understand 

if there is an interaction between the two independent 

variables on the dependent variable.  
 

Example:  
 

Two-way ANOVA is used to understand whether there is an interaction 

between gender and educational level on test anxiety amongst 

university students, where gender (males/females) and education level 

(undergraduate/postgraduate) are independent variables, and test 

anxiety is dependent variable 
218 
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Example: 2 

 

To determine whether there is an 

interaction between physical activity level 

and gender on blood cholesterol 

concentration in children, where physical 

activity (low/moderate/high) and gender 

(male/female) are independent variables, 

and cholesterol concentration is dependent 

variable. 

219 

Example 

 

A researcher was interested in whether an individual's interest 

in politics was influenced by their level of education and 

gender. They recruited a random sample of participants to 

their study and asked them about their interest in politics, 

which they scored from 0 to 100, with higher scores 

indicating a greater interest in politics.  

 

The researcher then divided the participants by gender 

(Male/Female) and then again by level of education 

(School/College/University). 

 

The dependent variable is "interest in politics", and the 

two independent variables are "gender" and "education". 
220 
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• Enter the two independent 

variables, and label them Gender 

and Edu_Level.  

 

• For Gender, we code "males" as 

1 and "females" as 2, and for 

Edu_Level, we code "school" 

as 1, "college" as 2 and 

"university" as 3. 

 

• The participants' interest in 

politics – the dependent variable 

– enter under the variable name, 

Int_Politics.  

 

 

 

Two-way ANOVA in SPSS  

 

221 

Click Analyze > General Linear Model > Univariate...  

222 
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You will be presented with the Univariate dialogue box, as shown 

below: 

Transfer the dependent variable, Int_Politics, into the Dependent Variable: box, 

and transfer both independent variables, Gender and Edu_Level, into the Fixed 

Factor(s): box. 

223 

Click on the plots button.  

You will be presented with the Univariate: Profile Plots dialogue box, as 

shown below 

224 
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Transfer the independent variable, Edu_Level, from the Factors: 

box into the Horizontal Axis: box, and transfer the other 

independent variable, Gender, into the Separate Lines: box.  

Click the Add Button.  

You will see that "Edu_Level*Gender" has been added to the Plots: box, as 

shown above: 

 

Click the continue button.  225 

Click the   post hoc button. You will be presented with the Univariate: 

Post Hoc Multiple Comparisons for Observed Means dialogue box, 

as shown below: 

• Transfer Edu_Level from the Factor(s): box to the Post Hoc Tests for: box. 

 

• This will make the –Equal Variances Assumed– area become active and 

present you with some choices for which post hoc test to use.  

• The select Tukey post hoc test. 226 
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Click the continue button to return to the Univariate dialogue box. 

 

Click the options button.  

This will present you with the Univariate: Options dialogue box, 

as shown below: 

 

227 

Transfer Gender, Edu_Level and Gender*Edu_Level from the 

Factor(s) and Factor Interactions: box into the Display Means for: 

box.  

In the –Display– area, tick the Descriptive Statistics option. You will 

presented with the following screen: 
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Click the continue button to return to the Univariate dialogue box. 

Click the OK button to generate the output. 

 

229 

Plot of the results 

 

The plot of the mean "interest in 

politics" score for each combination of 

groups of "Gender" and "Edu_level" are 

plotted in a line graph, as shown below: 
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Statistical significance of the two-way ANOVA 

• Our independent variables (the "Gender" and "Edu_Level" rows) and their 

interaction (the "Gender*Edu_Level" row) have a statistically significant effect on 

the dependent variable, "interest in politics". 

• See from the "Sig." column that we have a statistically significant interaction at 

the p = .014 level. 

• There was no statistically significant difference in mean interest in politics 

between males and females (p = .207), but there were statistically significant 

differences between educational levels (p < .0005). 
231 

There is a statistically significant difference between all three different 

educational levels (p < .0005). 

Post hoc tests - Multiple Comparisons Table 
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Correlation Coefficients:  

The Pearson r & Spearman‘s 

rho 

Correlation Coefficients 

Definition: A correlation coefficient is a statistic that indicates the 
strength & direction of the relationship b/w 2 variables. 

 

 Correlation coefficients provide a single numerical value to 
represent the relationship b/w the 2 variables 

 

 Correlation coefficients ranges -1 to +1 

 

-1.00 (negative one) a perfect, inverse relationship 

 

+1.00 (positive one) a perfect, direct relationship 

 

  0.00 indicates no relationship   
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Different indices of correlation 

coefficient 

 Pearson product moment correlation coefficient (r) – 

used to assess the relationship between 2 normally 

distributed continuous variables (Parametric) 

 

 Spearman rank order correlation (rho) coefficient - 

used to assess the relationship between 2 continuous 

variables and one of which is not normally distributed     

(Non parametric) 

 

 Kendall‟s rank correlation coefficient - used to assess 

the relationship between 2 ordinal variables or one 

ordinal and one continuous variable (Non parametric) 

 

 

235 

Pearson Correlation 

Assumptions 
 Assumption #1: Your two variables should be measured at the 

interval or ratio level (i.e., they are continuous). 

 Assumption #2: There needs to be a linear relationship between 

the two variables. Check the linear relationship exists between your 

two variables, by scatterplot using SPSS. 

 Assumption #3: There should be no significant outliers. 

236 
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Assumptions 

 Assumption #3: There should be no 

significant outliers. 

 

 

 

 

 

 Assumption #4: Your variables should be 

approximately normally distributed.  
237 

Example 

 
 Person's height is related to how well they 

perform in a long jump.  

 The researcher recruited untrained 

individuals from the general population, 

measured their height and had them 

perform a long jump.  

 The researcher then investigated whether 

there is an association between height 

and long jump performance. 

 238 
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In SPSS, enter the two variables  

Height (i.e., the person's height) and JumpDist (i.e., long jump 

distance).  

Click Analyze > Correlate > Bivariate... on the menu system 

as shown below 

239 

 

 

You will be presented with the following screen: 

 

 

 

 

 

 
 

Transfer the variables Height and Jump_Dist into the Variables: box 

240 
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Make sure that the Pearson tick box is checked under the -Correlation 

Coefficients- area 

 Click the options button. If you wish to generate some 

descriptives, you can do it here by clicking on the 

relevant tickbox under the -Statistics- area. 

Click the  continue. 

Then Click the OK. 241 

Correlations table in the output 

 

 

 

Reporting the results: 
A Pearson product-moment correlation was run to determine 

the relationship between an individual's height and their 

performance in a long jump (distance jumped). There was a 

strong, positive correlation between height and distance 

jumped, which was statistically significant (r = .777, n = 27,                   

p < .0005). 

Pearson correlation coefficient, r, is 0.777, and that this is statistically significant                     

(p < 0.0005).  
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Linear Regression 

Analysis using 

SPSS 

Regression Analysis 

Regression Analysis is the estimation of the 

linear relationship between a dependent 

variable and one or more independent 

variables or covariates.  
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When to use Correlation and Linear 

regression  

 

 Correlation and linear regression are used 

when you have two measurement 

variables, such as  

 food intake and weight,  

drug dosage and blood pressure,  

air temperature and metabolic rate, etc.  

245 

Assumptions 
 

 Assumption #1: Your two variables should be measured at the 

continuous level (i.e., they are either interval or ratio variables). 

Examples of continuous variables include revision time (measured 

in hours), intelligence (measured using IQ score), exam 

performance (measured from 0 to 100), weight (measured in kg). 

 Assumption #2: There needs to be a linear relationship between 

the two variables.  
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Assumptions 

 Assumption #3: There should be no 

significant outliers. 

247 

Linear Regression and Correlation 

 In many situations in clinical studies we wish to 
attempt to answer the question:  How is the 
random variable X related to the random 
variable Y? 
 Ex:  How is smoking related to lung cancer? 

 Ex:  How is age related to development of Alzheimer‘s 
Disease? 

 Ex:  How is age related to blood pressure?  

Such questions are answered statistically using the 
concepts of Regression Analysis which looks for 
relationships among different variables (either negatively 
or positively) and Correlations, the strengths of the 
relationships 248 
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Linear Regression 

Scatterplots 

 In order to perform regression 

analysis visually, it helps to 

―graph‖ the points on a 

scatterplot 

 A visual relationship can often 

be observed when looking at 

these plots. 

 Need to draw the line of best fit. 

 Best fit means that the sum of 

the squares of the vertical 

distances from each point to 

the line is at minimum. 
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Is there a relationship between 

wing length and tail length in 

songbirds? 

Wing length cm Tail length cm 

10.4 7.4 

10.8 7.6 

11.1 7.9 

10.2 7.2 

10.3 7.4 

10.2 7.1 

10.7 7.4 

10.5 7.2 

10.8 7.8 

11.2 7.7 

10.6 7.8 

11.4 8.3 

Age (yr) 

  

Systolic blood 

pressure 

mm hg 

30 108 

30 110 

30 106 

40 125 

40 120 

40 118 

40 119 

50 132 

50 137 

50 134 

60 148 

60 151 

60 146 

60 147 

60 144 

70 162 

70 156 

70 164 

70 158 

70 159 

Is there a relationship between age and 

systolic blood pressure? 
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Linear Regression 

 The Linear Regression model postulates that 
two random variables X and Y are related by a 
straight line as follows: 

 
Y = a + bX  

 

Where 

  

 Y is the dependent variable 

 X is the independent variable 

   a is the intercept 

   b is the slope 
251 

 

LINEAR REGRESSION 
 

 Linear Regression estimates the coefficients of 

the linear equation, involving one independent 

variables that best predict the value of the 

dependent variable.  

 Examples: 

Birth weight of a baby (independent) and blood 

pressure (dependent) 

  Y = a + bX 

Blood pressure = a + b (body weight) 
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Example 

 A salesperson for a large car brand wants 

to determine whether there is a 

relationship between an individual's 

income and the price they pay for a car.  

 The individual's "income" is the 

independent variable and the "price" 

they pay for a car is the dependent 

variable. 

253 

SPSS  

 In SPSS Statistics, enter the two variables  

 Income (the independent variable), and  

Price (the dependent variable). 

254 
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 Click Analyze > Regression > Linear... 

on the top menu, as shown below: 

255 

You will be presented with the Linear 

Regression dialogue box 
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Transfer the independent variable, Income, 

into the Independent(s): box and the 

dependent variable, Price, into the 

Dependent: box.  

Click the OK button.  

257 

 

 The first table of interest is the Model Summary table, as 
shown below: 

 

 

 

 

 

 

 This table provides the R and R2 values.  

 The R value represents the simple correlation and is 0.873 
(the "R" Column), which indicates a high degree of 
correlation.  

 The R2 value (the "R Square" column) indicates how much of 
the total variation in the dependent variable, Price, can be 
explained by the independent variable, Income. In this 
case, 76.2% can be explained, which is very large. 
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 The next table is the ANOVA table, which reports how well the 
regression equation fits the data (i.e., predicts the dependent 
variable) and is shown below: 

 

 

 

 

 

 

 

 

 This table indicates that the regression model predicts the 
dependent variable significantly well.  

 How do we know this?  

 Look at the "Regression" row and go to the "Sig." column. This 
indicates the statistical significance of the regression model that 
was run. Here, p < 0.0005, which is less than 0.05, and indicates 
that, overall, the regression model statistically significantly predicts 
the outcome variable (i.e., it is a good fit for the data). 

259 

 The Coefficients table provides us with the necessary information 

to predict price from income, as well as determine whether income 

contributes statistically significantly to the model (by looking at the 

"Sig." column). Furthermore, we can use the values in the "B" 

column under the "Unstandardized Coefficients" column, as 

shown below: 

 

to present the regression equation as: 

Y = a+bX 

 

Price = 8287 + 0.564 (Income) 

a 

b 
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Probit Analysis 
using SPSS 

 Probit Analysis  

 

 Probit analysis is a type of regression used to analyze 
binomial response variables.  

 

 This procedure measures the relationship between the 
strength of a stimulus and the proportion of cases 
exhibiting a certain response to the stimulus.  

 

 Probit analysis is still the preferred statistical method in 
understanding dose-response relationships  
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Example. 

 How effective is a new pesticide at killing ants, and what 
is an appropriate concentration to use?  

 You might perform an experiment in which you expose 
samples of ants to different concentrations of the 
pesticide and then record the number of ants killed and 
the number of ants exposed.  

 Applying probit analysis to these data, you can 
determine the strength of the relationship between 
concentration and killing, and you can determine what 
the appropriate concentration of pesticide would be if 
you wanted to be sure to kill, say, 95% of exposed ants.  

263 

Probit Analysis 

 

  Remember that a binomial response 
variable refers to a response variable with 
only two outcomes.  

 For example:  

Flipping a coin: Heads or tails  

Testing beauty products: Rash/no rash  

The effectiveness or toxicity of pesticides: 
Death/no death  

 264 
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Application 

 Probit analysis is used to analyze many kinds of dose-
response or binomial response experiments in a variety 
of fields. 

 Probit Analysis is commonly used in toxicology to 
determine the relative toxicity of chemicals to living 
organisms.  

 This is done by testing the response of an organism 
under various concentrations of each of the chemicals in 
question and then comparing the concentrations at 
which one encounters a response. 

 The response is always binomial (e.g. death/no death) 

265 

Probit Analysis 

 Once a regression is run, the researcher can 
use the output of the probit analysis to compare 
the amount of chemical required to create the 
same response in each of the various chemicals. 

 There are many endpoints used to compare the 
differing toxicities of chemicals, but the LC50 
(liquids) or LD50 (solids) are the most widely 
used outcomes of the modern dose-response 
experiments.  

 The LC50/LD50 represent the concentration 
(LC50) or dose (LD50) at which 50% of the 
population responds.  
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EXAMPLE 

 For example, consider comparing the 

toxicity of two different pesticides to fish, 

pesticide A and pesticide B.  

 If the LC50 of pesticide A is 50ug/L and the 

LC50 of pesticide B is 10ug/L, pesticide B 

is more toxic than A because it only takes 

10ug/L to kill 50% of the fish, versus 

50ug/L of pesticide B.  

267 

To run the probit anaylsis in SPSS, 

follow the following simple steps: 
 Simply input a minimum 

of three columns into 
the Data Editor  

 Number of individuals 
per container that 
responded  

 Total of individuals per 
container  

 Concentrations  
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Probit analysis in SPSS 

 On the main menu Click Analyze, 

Regression, Probit, choose the log of your 

choice to transform: 
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Probit analysis in SPSS 

 Then set your number 
responded column as the 
―Response Frequency‖, the total 
number per container as the 
―Total Observed‖, and the 
concentrations as the 
―Covariates‖.  

 Don‘t forget to select the log 
base 10 to transform your 
concentrations.  

 

 

 Click the OK button in the Probit 
Analysis dialog box to run the 
analysis.  

 The output will be displayed in a 
new SPSS Viewer window.  
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LC50 =  36.624 mg/L 

with 95 % 

confidence interval 

of 27.539 – 48.823 

271 

NON PARAMETRIC 

STATISTICS 
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Chi-Square Test for 

Association using 

SPSS  

Chi-square statistic 

 Two non-parametric hypothesis tests 

using the chi-square statistic:   

 

the chi-square test for goodness of fit 

and  
 Goodness of fit refers to how close the observed 

data are to those predicted from a hypothesis 

 

the chi-square test for independence.   
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The chi-square test for independence, also called 

Pearson's chi-square test or the chi-square test of 

association, is used to discover if there is a 

relationship between two categorical variables. 

 

Assumptions: 
 

Assumption #1: Your two variables should be measured at an ordinal or nominal 

level (i.e., categorical data).  

 

Assumption #2: Your two variable should consist of two or more categorical, 

independent groups. Example independent variables that meet this criterion 

include gender (2 groups: Males and Females), profession (e.g., 5 groups: surgeon, 

doctor, nurse, dentist, therapist), and so forth. 

Chi-Square Test for Association using 

SPSS  

275 

Example: 

 

An educator would like to know whether gender 

(male/female) is associated with the preferred 

type of learning medium (online vs. books). We 

have two nominal variables: Gender (male/female) 

and Preferred Learning Medium (online/books). 
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In SPSS enter the two variables gender and learning medium 

Gender in one column ( code for male 1 & female 2) &  

Preferred_Learning_Medium in another column  (code for online 1 and books 2) 

Click Analyze > Descriptives Statistics > Crosstabs... on the top 

menu, as shown below: 277 

Transfer one of the variables into the Row(s): box and the other variable into the 

Column(s): box. In our example, we will transfer the Gender variable into the 

Row(s): box and Preferred_Learning_Medium into the Column(s): box.  

Then Click Statistics Button.  
278 
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Click Statistics Button.  

Select the Chi-square and Phi and 

Cramer's V options, as shown below: 

Click the Continue Button. 
279 

Click the Cells Button . 
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Select Observed from the – Counts – area, and Row, Column 

and Total from the – Percentages– area, as shown below: 

 

Click the Continue Button. 

 

 

 
281 

This option allows you to change the order 

of the values to either ascending or 

descending. 

 

Once you have made your choice, click the 

Continue Button. 

 

Click the  OK button to generate your 

output. 
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The Crosstabulation Table (Gender*Preferred Learning Medium 

Crosstabulation) 

This table tells you both males and females prefer to learn using 

online materials versus books. 

283 

Results of the "Pearson Chi-Square" row. We can see 

here that χ(1) = 0.487, p = .485. This tells that there is no 

statistically significant association between Gender and 

Preferred Learning Medium; that is, both Males and 

Females equally prefer online learning versus books. 
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Phi and Cramer's V are both tests of the strength of association. We 

can see that the strength of association between the variables is 

very weak. 

The clustered bar chart produced and 

highlights the group categories and the 

frequency of counts in these groups. 
285 

Chi-Square 

Goodness-of-Fit Test 

in SPSS 
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• The chi-square goodness-of-fit test is a single-sample 

nonparametric test, also referred to as the one-sample 

goodness-of-fit test or Pearson's chi-square 

goodness-of-fit test.  

 

• It is used to determine whether the distribution of cases 

(e.g., participants) in a single categorical variable (e.g., 

"gender", consisting of two groups: "males" and "females") 

follows a known or hypothesised distribution 

Chi-Square Goodness-of-Fit Test 

287 

Chi-Square Goodness-of-Fit Test in SPSS 

 Suppose we wish to test the null hypothesis that Dr. Suresh gives 

equal numbers of A‘s, B‘s, C‘s, D‘s, and F‘s as final grades in his 

Bioinformatics classes.   

 The observed frequencies are:  A: 6,   B: 24,   C: 50,   D: 10,   F: 10. 

 The data are entered into SPSS like this: 

 H0: Null hypothesis that the counts are uniformly distributed across 

the categories  

 Ha: The counts are not equal 
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Chi Square SPSS Data Input 

Level of measurement is Nominal 

Enter Value Labels 

289 

Chi-Square Goodness-of-Fit 

Test in SPSS 

 Now tell SPSS to weight the cases by 

Count.  Click Data, Weight Cases, 

Weight Cases By Count. 

OK. 
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Click Analyze, Nonparametric Tests, Chi-square.  Move the Grade into the Test 

Variable List.  By default SPSS will use all categories and will test the hypothesis that 

the counts are, in the population, uniformly distributed across categories. 

Click OK 
291 

Grade

10 20.0 -10.0

10 20.0 -10.0

50 20.0 30.0

24 20.0 4.0

6 20.0 -14.0

100

F

D

C

B

A

Total

Observed N Expected N Residual

We reject the null hypothesis that the counts are uniformly distributed across 

the categories, 2(4, N = 100) = 65.60 p < .001. 

Test Statistics

65.600

4

.000

Chi-Squarea

df

Asymp. Sig.

Grade

0 cells (.0%) have expected frequencies less than

5. The minimum expected cell frequency is 20.0.

a. 
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Mann-Whitney Test 

in SPSS 

Mann-Whitney U test 

 The Mann-Whitney U test is used to compare 

differences between two independent groups 

when the dependent variable is either ordinal or 

continuous, but not normally distributed.  

 For example, you could use the Mann-Whitney U test 

to understand whether salaries, measured on a 

continuous scale, differed based on educational level 

(i.e., your dependent variable would be "salary" and 

your independent variable would be "educational 

level", which has two groups: "high school" and 

"university").  
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Assumptions 

 
 Assumption #1: Your dependent variable should be measured at the ordinal 

or continuous level. Examples of ordinal variables include Likert items (e.g., a 

7-point scale from "strongly agree" through to "strongly disagree"). Examples of 

continuous variables include revision time (measured in hours),exam 

performance (measured from 0 to 100), weight (measured in kg).  

 Assumption #2: Your independent variable should consist of two 

categorical, independent groups. Example gender (2 groups: male or female), 

employment status (2 groups: employed or unemployed), smoker (2 groups: yes 

or no), and so forth.  

 Assumption #3: Independence of observations, which means that 

there is no relationship between the observations in each group or 

between the groups themselves.  

 For example, there must be different participants in each group with no 

participant being in more than one group.  

 Assumption #4: A Mann-Whitney U test can be used when your two 

variables are not normally distributed 

295 

Example 

 
 The concentration of cholesterol in the blood is associated with the risk of 

developing heart disease, such that higher concentrations of cholesterol 
indicate a higher level of risk, and lower concentrations indicate a lower 
level of risk.  

 If you lower the concentration of cholesterol in the blood, your risk for 
developing heart disease can be reduced. Being overweight and/or 
physically inactive increases the concentration of cholesterol in your 
blood. Both exercise and weight loss can reduce cholesterol 
concentration. However, it is not known whether exercise or weight loss is 
best for lowering cholesterol concentration.  

 Therefore, a researcher decided to investigate whether an exercise or 
weight loss intervention was more effective in lowering cholesterol levels. 
The researcher recruited a random sample of inactive males that 
were classified as overweight. This sample was then randomly split into 
two groups: Group 1 underwent a calorie-controlled diet (i.e., the 
'diet' group) and Group 2 undertook an exercise-training programme 
(i.e., the 'exercise' group).  

 In order to determine which treatment programme was more effective, 
cholesterol concentrations were compared between the two groups at the 
end of the treatment programmes. 
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Mann-Whitney U test 

 In SPSS Statistics, enter the scores for cholesterol 
concentration, our dependent variable, under the 
variable name Cholesterol.  

 Next, create a grouping variable, called Group, 
which represented our independent variable. 

 Since our independent variable had two groups - 
'diet' and 'exercise' – Give the diet group a value 
of "1" and the exercise group a value of "2". 
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303 

Interpretation: 

It can be concluded that cholesterol concentration in 

the diet group was statistically significantly higher 

than the exercise group (U = 110, p = .014). 

Depending on the size of your groups 304 
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Wilcoxon Signed Rank 

Test – two related 

samples 

 The Wilcoxon signed-rank test is the 

nonparametric test equivalent to the dependent t-

test (paired sample t test) 

 Wilcoxon signed-rank test does not assume 

normality in the data, it can be used when this 

assumption has been violated and the use of the 

dependent t-test is inappropriate. 

  It is used to compare two sets of scores that 

come from the same participants 

 To test difference between paired data 

 

 

Wilcoxon signed-ranks test 
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Assumption #1: Dependent variable should be measured at 

the ordinal or continuous level. 

 

Assumption #2: Independent variable should consist of two 

categorical, "related groups" or "matched pairs". "Related 

groups" indicates that the same subjects are present in both 

groups. Same subjects in each group is because each subject 

has been measured on two occasions on the same dependent 

variable. 

 

Assumption #3: The distribution of the differences 

between the two related groups needs to be symmetrical in 

shape 

Wilcoxon signed-ranks test - 

Assumptions 
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Wilcoxon Signed Rank Test – two 

related samples – paired samples 

Resting Energy Expenditure (REE) for 

Patient with Cystic Fibrosis 

 A researcher believes that patients with 

cystic fibrosis (CF) expend greater energy 

during resting than those without CF.   

 To obtain a fair comparison matched 13 

patients with CF to 13 patients without CF. 

308 



155 

Example: Wilcoxon Signed Rank Test 
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Example 
 A researcher is interested in finding methods to reduce lower back 

pain in individuals without having to use drugs.  

 The researcher thinks that having acupuncture in the lower back 

might reduce back pain.  

 To investigate this, the researcher recruits 25 participants to their 

study. At the beginning of the study, the researcher asks the 

participants to rate their back pain on a scale of 1 to 10, with 10 

indicating the greatest level of pain.  

 After 4 weeks of twice weekly acupuncture, the participants are asked 

again to indicate their level of back pain on a scale of 1 to 10, with 10 

indicating the greatest level of pain.  

 The researcher wishes to understand whether the participants' pain 

levels changed after they had undergone the acupuncture, so a 

Wilcoxon signed-rank test is run. 
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The results showed that a 4 week, 

twice weekly acupuncture treatment 

course did not reduce a statistically 

significant change in lower back pain 

in individuals with existing lower back 

pain (Z = -1.807, p = 0.071). The, 

median Pain Score rating is  5.0 in 

both pre- and post-treatment. 
317 

McNemar‟s test using 

SPSS 
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McNemar‟s test using SPSS 

 This test is used to determine if there are 

differences on a dichotomous 

dependent variable between two related 

groups.  

 It can be considered to be similar to the 

paired-samples t-test, but for a 

dichotomous rather than a continuous 

dependent variable 

319 

Assumptions 

 Assumption #1: Will have one categorical dependent variable with 

two categories (i.e., a dichotomous variable) and one categorical 

independent variable with two related groups. Examples of 

dichotomous variables include exam performance (two groups: "pass" 

and "fail"), preferred choice of cereal brand (two groups: "brand A" and 

"brand B") 

 Assumption #2: The two groups of your dependent variable must be 

mutually exclusive. This means that no groups can overlap. In other 

words, a participant can only be in one of the two groups; they cannot be 

in both groups at the same time.  

 Assumption #3: The cases (e.g., participants) are a random sample 

from the population of interest.  

320 
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Example 

 
 A researcher wanted to investigate the impact of an 

intervention on smoking. In this study, 50 participants 

were recruited to take part, consisting of 25 smokers and 

25 non-smokers.  

 All participants watched an emotive video showing the 

impact of health, consequences and deaths from 

smoking-related cancers had on families. After four weeks 

after this video intervention, the same participants were 

asked whether they remained smokers or non-smokers. 

 Therefore, participants were categorized as being either 

smokers or non-smokers before the intervention and then 

re-assessed as either smokers or non-smokers after the 

intervention.  
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 Fifty participants were recruited to take part in an intervention designed to warn about 

the dangers of smoking. An exact McNemar's test determined that there was a 

statistically significant difference in the proportion of non-smokers pre- and post-

intervention, p = .027. 
326 
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Kruskal-Wallis H Test 

using SPSS 

Kruskal-Wallis H Test using SPSS 

 The Kruskal-Wallis H test is a rank-based nonparametric test that can 

be used to determine if there are statistically significant differences 

between two or more groups of an independent variable on a 

continuous or ordinal dependent variable.  

 It is considered the nonparametric alternative to the one-way ANOVA, 

and an extension of the Mann-Whitney U test to allow the comparison of 

more than two independent groups. 

 Example, to understand whether exam performance, measured on a 

continuous scale from 0-100, differed based on test anxiety levels (i.e., 

your dependent variable would be "exam performance" and your 

independent variable would be "test anxiety level", which has three 

independent groups: students with "low", "medium" and "high" test 

anxiety levels). 

328 
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Assumptions 

 Assumption #1: Dependent variable should be measured 

at the ordinal or continuous level (i.e., interval or ratio).  

 Assumption #2: Independent variable should consist of 

two or more categorical, independent groups. Kruskal-

Wallis H test is used when you have three or more 

categorical, independent groups. 
 Example physical activity level (e.g., four groups: sedentary, 

low, moderate and high), profession (e.g., five groups: surgeon, 

doctor, nurse, dentist, therapist),  

 Assumption #3: You should have independence of 

observations, which means that there is no relationship 

between the observations in each group or between the 

groups themselves.  

329 

Example 

 
 A medical researcher has heard anecdotal evidence that certain                               

anti-depressive drugs can have the positive side effect of lowering 

neurological pain in those individuals with chronic, neurological back pain, 

when administered in doses lower than those prescribed for depression.  

 The medical researcher would like to investigate this anecdotal evidence 

with a study. The researcher identifies 3 well-known, anti-depressive 

drugs which might have this positive side effect, and labels them Drug A, 

Drug B and Drug C.  

 The researcher then recruits a group of 60 individuals with a similar level 

of back pain and randomly assigns them to one of three groups – Drug A, 

Drug B or Drug C treatment groups – and prescribes the relevant drug for 

a 4 week period. At the end of the 4 week period, the researcher asks the 

participants to rate their back pain on a scale of 1 to 10, with 10 indicating 

the greatest level of pain. The researcher wants to compare the levels 

of pain experienced by the different groups at the end of the drug 

treatment period.  
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Click options 
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Interpretation: 

A Kruskal-Wallis test showed that there 

was a statistically significant difference in 

pain score between the different drug 

treatments, χ2(2) = 8.520, p = 0.014, with 

a mean rank pain score of 35.33 for Drug 

A, 34.83 for Drug B and 21.35 for Drug 

C.  

335 

Friedman Test using 

SPSS 
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Friedman test 

 The Friedman test is the non-parametric 

alternative to the one-way ANOVA with 

repeated measures.  

 It is used to test for differences between 

groups when the dependent variable being 

measured is ordinal.  

 It can also be used for continuous data that 

has violated the assumptions necessary to 

run the one-way ANOVA with repeated 

measures  

337 

Assumptions 

  Assumption #1: One group that is measured 

on three or more different occasions. 

 Assumption #2: Group is a random sample 

from the population. 

 Assumption #3: Your dependent variable 

should be measured at the ordinal or 

continuous level.  

 Assumption #4: Samples do NOT need to be 

normally distributed. 
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Example 
 A researcher wants to examine whether music has an effect on the 

perceived psychological effort required to perform an exercise session.  

 The dependent variable is "perceived effort to perform exercise" and 

the independent variable is "music type", which consists of three 

groups: "no music", "classical music" and "dance music".  

 To test whether music has an effect on the perceived psychological 

effort required to perform an exercise session, the researcher recruited 

12 runners who each ran three times on a treadmill for 30 minutes.  

 For consistency, the treadmill speed was the same for all three runs. In 

a random order, each subject ran: (a) listening to no music at all; (b) 

listening to classical music; and (c) listening to dance music.  

 At the end of each run, subjects were asked to record how hard the 

running session felt on a scale of 1 to 10, with 1 being easy and 10 

extremely hard 
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C 

Transfer the dependent 

variables none, classical and 

dance to the Test Variables: 

Click Friedman 

Click Statistics 
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We can see that there is an overall statistically significant difference between the 

mean ranks of the related groups. 

Reporting:  

There was a statistically significant difference in perceived effort depending on 

which type of music was listened to whilst running, χ2(2) = 7.600, p = 0.022. 343 

Reliability  

Cronbach's Alpha (α) 

using SPSS 
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• Cronbach's alpha is the most common measure 

of internal consistency ("reliability").  

 

• It is most commonly used when you have multiple 

Likert questions in a survey/questionnaire that 

form a scale and you wish to determine if the 

scale is reliable. 

Cronbach's Alpha (α) using SPSS 

345 

Example 

 

A researcher has devised a nine-question questionnaire 

to measure how safe people feel at work at an industrial 

complex.  

Each question was a 5-point Likert item from "strongly 

disagree" to "strongly agree".  
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Enter the results of the nine questions. Questions label as Qu1 through to 

Qu9.  

347 

Click Analyze > Scale > Reliability Analysis... on the top menu, 

as shown below: 

348 
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You will be presented with the Reliability 

Analysis dialogue box, as shown below: 

Transfer the variables Qu1 to 

Qu9 into the Items: box.  

Leave the Model: set as 

"Alpha", which represents 

Cronbach's alpha in SPSS.  

349 

Click on the Statistics 

Button, which will open 

the Reliability Analysis: 

Statistics dialogue box  

350 
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Select the Item, Scale and Scale if item deleted options in the –

Descriptives for– area, and the Correlations option in the –Inter-Item– 

area, as shown below: 

 

 

Click OK to generate the output. 

 

Click Continue. This will return you to 

the Reliability Analysis dialogue box. 

351 

The Item-Total Statistics table presents the "Cronbach's Alpha 

if Item Deleted" in the final column, as shown below: 

Cronbach's alpha is 0.805, which indicates a 

high level of internal consistency for our 

scale. 

Cronbach's alpha value is 0.70 and above is 

considered good.  

  

Each column presents the value that Cronbach's alpha would be if that particular item was deleted 

from the scale. Except question 8, would result in a lower Cronbach's alpha.  
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Multiple Regression 

Analysis using SPSS 

 

Multiple regression 

 Multiple regression is an extension of simple linear regression. It is used 

when we want to predict the value of a variable based on the value of 

two or more other variables. 

 The variable we want to predict is called the dependent variable (or 

sometimes, the outcome, target or criterion variable).  

 The variables we are using to predict the value of the dependent 

variable are called the independent variables (or predictor, 

explanatory variables). 

Examples: 

 The exam performance can be predicted based on revision time, test 

anxiety, lecture attendance and gender.  

 The daily cigarette consumption can be predicted based on smoking 

duration, age when started smoking, smoker type, income and 

gender. 

 354 
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Multiple regression 

 Multiple regression also allows us to determine the 

overall fit (variance explained) of the model and the 

relative contribution of each of the predictors to the 

total variance explained.  

 For example, you might want to know how much of the 

variation in exam performance can be explained by 

revision time, test anxiety, lecture attendance and 

gender "as a whole", but also the "relative contribution" 

of each independent variable in explaining the variance. 

355 

Various types of Regression 

analysis 
  Linear Regression  

  Stepwise Regression  

  Group-wise Regression  

  Hierarchical Regression  

  Logistic Regression  

  Regression  with  dummy Variable 

  Regression with moderating variable 

  Non-Linear Regression  
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Multiple Linear Regression 

 Linear regression is used for three main 

purposes 

1. Used to assess how much each variable 

contributes in determining the value of the 

dependent variable   

2. What direction (positive or negative) they 

contribute 

3. Their relative importance in deciding the value of 

dependent variable 

The R2 and F Significance determine the 

reliability and validity of the model 
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Assumptions 

 
 Assumption #1: Dependent variable should be measured on a 

continuous scale (i.e., it is either an interval or ratio variable). 

 Assumption #2: Should have two or more independent variables, 

which can be either continuous (i.e., an interval or ratio variable) or 

categorical (i.e., an ordinal or nominal variable). 

 Assumption #3: There should be linear relationship between (a) the 

dependent variable and each of your independent variables, and (b) 

the dependent variable and the independent variables collectively. 

 Assumption #4: The data must not show multicollinearity, which 

occurs when we have two or more independent variables that are 

highly correlated with each other. 

 Assumption #5: There should be no significant outliers, high 

leverage points or highly influential points. 
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Example 

 
 A health researcher wants to predict "VO2max", an indicator of 

fitness and health. [VO2 max is a measure of the maximum 

volume of oxygen that an individaul can use. It is measured 

in millilitres per kilogramme of body weight per minute 

(ml/kg/min)].  

 Is it possible to predict an individual's VO2max based on 

attributes that can be measured more easily and cheaply.  

 The researcher recruited 100 participants to perform a 

maximum VO2max test, but also recorded their "age", 

"weight", "heart rate" and "gender".  

 The researcher's goal is to predict VO2max based on these four 

attributes: age, weight, heart rate and gender. 

 359 

Variable View 
 In the variable view key in the six variables: (1) 

VO2max, which is the maximal aerobic capacity; (2) 

age; (3) weight, which is the participant's weight; (4) 

heart rate; (5) gender,; and (6) caseno. 
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Click Analyze > Regression > Linear 

361 

Transfer the dependent variable, VO2max, into the Dependent: and the independent 

variables, age, weight, heart_rate and gender into the Independent(s) 
362 
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Select Confidence 

intervals in the –

Regression 

Coefficients – area 

leaving the Level(%): 

option at "95".  

364 
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 "R" column represents the value of R, the multiple 

correlation coefficient.  

 R can be used to measure the quality of the prediction of 

the dependent variable 

 The "R Square" column represents the R2 value, which 

is the proportion of variance in the dependent variable 

that can be explained by the independent variables. 

 Independent variables explain 57.7% of the variability of 

our dependent variable,  
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The independent variables statistically significantly predict the dependent variable, 

F(4, 95) = 32.393, p < .0005 

367 

The equation to predict VO2max from age, weight, heart_rate, gender, is: 

 

Predicted VO2max = 87.83 – (0.165 x age) – (0.385 x weight) – (0.118 x heart_rate) + 

(13.208 x gender) 

 Unstandardized coefficients indicate how much the dependent variable varies with 

an independent variable when all other independent variables are held constant. 

Consider the effect of age in this example.  

 The unstandardized coefficient, for age is equal to -0.165.  
 Each one year increase in age, there is a decrease in VO2max of 0.165 ml/min/kg. 

 The standardized coefficients indicate which independent variable 

contributes maximum to dependent variable. They rank the independent 

variables. Age comes first followed by weight, heart rate and so on.  

 368 



185 

• This table provides the statistical significance of each of the independent 

variables. 

• This tests whether the unstandardized (or standardized) coefficients are equal 

to 0 (zero) in the population.  

• p < .05, you can conclude that the coefficients are statistically significantly 

different to 0 (zero). 

Report 

A multiple regression was run to predict VO2max from gender, age, weight and 

heart rate. These variables statistically significantly predicted VO2max, F(4, 95) = 

32.393, p < .0005, R2 = .577. All four variables added statistically significantly to the 

prediction, p < .05. 

369 

Stepwise Regression 

Analysis using SPSS 

 



186 

Stepwise Regression methods 

 Researchers should build models with a few important independent 

variables 

 What are those very important variables? How to decide? Stepwise 

regression addresses this problem 

 Some researchers will model their research problem with more than 10 

variables or so.  

 If all independent variables are analyzed simultaneously the output 

produced is with all insignificant variables with one R2 and F values. 

 To see clearly the variables which enter the model, the R2 produced, 

incremental R2 , different F values will be an added advantage to the 

researchers to write clearly the research report.  

 The only requirements are that the data is normally distributed (or 

rather, that the residuals are), and that there is no correlation between 

the independent variables (known as collinearity).  
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Groupwise Regression 

Analysis using SPSS 

 

Group-wise Regression 

 In Previous example VO2Max we have two groups 

of participants male and female.  

  It is interesting to find and present results 

separately to know more about the independent 

variables in male and female rather than giving 

results in general. 

 Sometimes we will compare groups separately to 

get more insight. For example young age group 

how is it different from other age groups  

 We have to run regression two times 
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Regression Analysis for 

dummy variables using 

SPSS 
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Regression with dummy variable 

 Dummy variables are included in the model to capture the 

effect of dichotomous variables like good or bad (good may 

be 1 and bad may be zero)   

 For example, a researcher wants to study the variables 

that determine the house prices 

 The house price is dependent on SQ feet, age and 

locality. Apart from this present condition of the house is 

also important.   

 If the house is maintained well it will get good price and 

vice versa.  
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SPSS worksheet and data 

Dummy Variable 
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SPSS worksheet and data 

389 

Dummy Variable included 

Dummy Variable 

2 

3 

Dummy Variable 

2 3 
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Results – Output 1 

Correlation Coefficients 

391 

Results – Output 2 

Good R2 

Variables fit the model nicely 

Condition does not determine the price as sig is > 0.05 
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Hierarchical Regression 

analysis using SPSS 

Hierarchical regression 

 Researcher specifies some order of entry based on 

theoretical considerations 

 They might start with the most important predictor(s) to 

see what they do on their own before those of lesser 

theoretical interest are added 

 Otherwise, might start with those of lesser interest, and 

see what they add to the equation (in terms of R2) 

 This test is performed adding main independent 

variables first and followed by a group of demographic 

variables in the analysis by hierarchy  
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Example 

 A research hypothesis might state that there are differences 

between the average salary for male employees and female 

employees, even after we take into account differences between 

education levels and prior work experience. 

 

 In hierarchical regression, the independent variables are entered 

into the analysis in a sequence of blocks, or groups that may contain 

one or more variables. In the example above, education and work 

experience would be entered in the first block and sex would be 

entered in the second block. 
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Example 
 The prediction of life satisfaction seven years 

after college from the variables that can be 

measured while the student is in college. 
 Age  

 Gender (0=Male, 1=Female)  

 Married (0=No, 1=Yes)  

 IncomeC Income in College (in thousands)  

 HealthC Score on Health Inventory in College  

 ChildC Number of Children while in College  

 LifeSatC Score on Life Satisfaction Inventory in College  

 SES Socio Economic Status of Parents  

 Smoker (0=No, 1=Yes)  

 SpiritC Score on Spritiuality Inventory in College  

 Finish Finish the program in college (0=No, 1=Yes)  

 LifeSat Score on Life Satisfaction Inventory seven years after College  

 Income Income seven years after College (in thousands)  
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• To examine the prediction of life satisfaction seven years after 

college in several stages. 

•  In the first stage, he/she enters demographic variables that the 

individual has little or no control over, age, gender, and socio-

economic status of parents.  

• In the second block variables are entered that the individual has at 

least some control, such as smoking, having children, being 

married, etc. The third block consists of the two attitudinal 

variables, life satisfaction and spirituality. 397 
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1. Transfer age, gender, and socio-economic status of parents. Then 

click next  

2. Transfer Smoking, having children, being married Then click next  

3. Life satisfaction and spirituality. 
399 
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Demographic Variables coefficients 
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Binary Logistics 

Regression analysis using 

SPSS 

Binary Logistics Regression 

analysis 

 A binomial logistic regression (often 

referred to simply as logistic regression), 

predicts the probability that an observation 

falls into one of two categories of a 

dichotomous dependent variable based on 

one or more independent variables that 

can be either continuous or categorical. 

404 
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Example 
 Exam performance can be predicted based on revision time, test 

anxiety and lecture attendance (i.e., where the dependent variable is 

"exam performance", measured on a dichotomous scale – 

"passed" or "failed" – and you have three independent variables: 

"revision time", "test anxiety" and "lecture attendance").  

 

 Drug use can be predicted based on prior criminal convictions, drug 

use amongst friends, income, age and gender (i.e., where the 

dependent variable is "drug use", measured on a dichotomous 

scale – "yes" or "no" – and you have five independent variables: 

"prior criminal convictions", "drug use amongst friends", 

"income", "age" and "gender"). 

405 

Assumptions 
 Assumption #1: Dependent variable should be measured on a 

dichotomous scale. Examples of dichotomous variables include 

gender (two groups: "males" and "females"), presence of heart 

disease (two groups: "yes" and "no"), body composition (two groups: 

"obese" or "not obese") 

 Assumption #2: One or more independent variables, which can 

be either continuous (i.e., an interval or ratio variable) or 

categorical (i.e., an ordinal or nominal variable).  

 Assumption #3: Independence of observations and the 

dependent variable should have mutually exclusive and 

exhaustive categories. 

 Assumption #4: There needs to be a linear relationship between 

any continuous independent variables and the logit 

transformation of the dependent variable.  
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Example 

  A health researcher wants to be able to predict whether the "incidence of 

heart disease" can be predicted based on "age", "weight", "gender" and 

"VO2max" (i.e., where VO2max refers to maximal aerobic capacity, an 

indicator of fitness and health).  

 The researcher recruited 100 participants to perform a maximum VO2max 

test as well as he recorded their age, weight and gender. The 

participants were also evaluated for the presence of heart disease (Yes 

or No). 

 There are six variables: 

(1) Heart_disease, which is whether the participant has heart disease: "yes" or "no" 

(i.e., the dependent variable);  

(2) VO2max, which is the maximal aerobic capacity; 

 (3) age, which is the participant's age;  

(4) weight, which is the participant's weight (technically, it is their 'mass'); and  

(5) gender, which is the participant's gender (i.e., the independent variables); and  

(6) Caseno, which is the case number. 
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Click Analyze > Regression > Binary Logistic... 
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Transfer the dependent 

variable, heart_disease, into 

the Dependent: box, and the 

independent variables, age, 

weight, gender and VO2max 

into the Covariates 

Click the categorical Button 

409 

 

In the –Change Contrast– 

area, change the 

Reference Category: from 

the Last option to the First 

option. Then, click the 

button, as shown below: 

410 
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411 

The explained variation in the dependent variable based on our model 

ranges from 24.0% to 33.0%, 

You can see that age (p = .003), gender (p = .021) and VO2max (p = .039) added significantly to the model/prediction, but 

weight (p = .799) did not add significantly to the model. We can use the information in the "Variables in the Equation" table to 

predict the probability of an event occurring based on a one unit change in an independent variable when all other 

independent variables are kept constant. 

For example, the table shows that the odds of having heart disease ("yes" category) is 7.026 times greater for males as 

opposed to females. 

412 
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Report 

 A logistic regression was performed to ascertain the effects of age, 

weight, gender and VO2max on the likelihood that participants have 

heart disease.  

 The model explained 33.0% (Nagelkerke R2) of the variance in heart 

disease. Males were 7.02 times more likely to exhibit heart disease 

than females.  

 Increasing age was associated with an increased likelihood of 

exhibiting heart disease, but increasing VO2max was associated with a 

reduction in the likelihood of exhibiting heart disease. 

413 

Moderator Analysis 

using SPSS 
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Moderator 

 A moderator is a variable that alters the direction or 
strength of the relationship between a predictor 
(independent) and an outcome (dependent) 

 Really, it is just an interaction – the effect of one variable 
depends on the level of another. 

 A moderator analysis is used to determine whether the 
relationship between two variables depends on (is 
moderated by) the value of a third variable. This 
relationship is commonly between:  
 (a) a continuous dependent variable and continuous independent 

variable, which is modified by a dichotomous moderator variable;  

 (b) a continuous dependent variable and continuous independent 
variable, which is modified by a polytomous moderator variable; or  

 (c) a continuous dependent variable and continuous independent 
variable, which is modified by a continuous moderator variable 

 
415 

What is the definition of 
moderation? 
A moderator analysis is used to determine 

whether the relationship between two 
variables depends on (is moderated by) 
the value of a third variable. 

IQ (IV) 

Study Hrs (IV) 

Exam scores (DV) 
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Moderators 
IQ (IV) 

Study Hrs (IV) 

Exam scores (DV) 

417 
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Example 

 The relationship between HDL cholesterol and amount of 

exercise performed per week is different for normal 

weight and obese participants (i.e., the continuous 

dependent variable is "HDL cholesterol", the 

continuous independent variable is "amount of 

exercise performed per week" and the dichotomous 

moderator variable is "body composition", consisting 

of two groups: "normal weight" and "obese")? 

419 

Example 

 The relationship between salary and years of 

education is moderated by gender (i.e., the 

continuous dependent variable is "salary", the 

continuous independent variable is "years of 

education" and the dichotomous moderator 

variable is "gender", which consists of two 

groups: "males" and "females").  

 If it is, gender (i.e., the dichotomous moderator 

variable) moderates the relationship between 

the years of education and salary. 
420 
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Example in SPSS 

 The high-density lipoprotein cholesterol (HDL 

cholesterol, for short) is linked to good heart 

health. The higher the concentration of HDL 

cholesterol in the blood the better. 

 It is known that exercise can increase HDL 

cholesterol concentration. A researcher wants 

to understand whether this relationship is 

similar in normal weight and obese 

individuals 

421 

 

Click Analyze > Regression > Linear. 
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R2 change 0.068 is 6.8% (i.e., .068 x 100 = 6.8%), which is the percentage 

increase in the variation explained by the addition of the interaction term 

Using the values obtained above, we can write the regression equation 

 

HDL = 32.694 + (0.016 x physical_activity) + (13.353 x normal) + (0.080 x 

pa_x_normal) 
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Mediator analysis using 

SPSS 

Mediator 

Is there an association of the 

independent variable with the 

mediator? 

 Exam Score (DV) 

 IQ scores (Predictor variable 

or Independent Variable) 

 Weekly study hrs (Mediator) 
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431 

 

The study hrs is a mediator variable. When we add mediator variable and the 

strength or direction of IV and DV decreases 
432 
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MANOVA:  Multivariate 

Analysis of Variance 

using SPSS 

Review of ANOVA: Univariate Analysis of Variance 

 An univariate analysis of variance looks for the causal impact 
of a nominal level independent variable (factor) on a single, 
and interval level dependent variable. 

 

 Analysis of Variance (ANOVA):  Required when there 
are three or more levels or conditions of the independent 
variable. 

 What is the salary (dependent variable) of  different 
degree levels graduates in Malaysia (MBBS, BDS, BSc 
Biotech, Business degree, Physiotherapist 
(Independent variables) 
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Review of Factorial ANOVA 

 Two-way ANOVA is applied to a situation in 
which you have two independent nominal-
level variables and one interval or better 
dependent variable 

 Each of the independent variables may have any 
number of levels or conditions (e.g., Treatment 1, 
Treatment 2, Treatment 3…… No Treatment) 

 In a two-way ANOVA you will obtain 3 F ratios 
 One of these will tell you if your first independent variable has a significant 

main effect on the DV 

 A second will tell you if your second independent variable has a significant 
main effect on the DV 

 The third will tell you if the interaction of the two independent variables has 
a significant effect on the DV,  that is, if the impact of one IV depends on 

the level of the other  
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Review:  Factorial ANOVA 

Example 

Tests of Hypotheses:   
(1) There is no significant main effect for education level (F(2, 58) = 1.685, p = 

.194, partial eta squared = .055) (red dots) 
(2) There is no significant main effect for marital status (F (1, 58) = .441, p = 

.509, partial eta squared = .008)(green dots) 
(3) There is a significant interaction effect of marital status and education level (F 

(2, 58) = 3.586, p = .034, partial eta squared = .110) (blue dots) 
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MANOVA:  What Kinds of Hypotheses 

Can it Test? 

 A MANOVA or multivariate analysis of variance is a way to test the 
hypothesis that one or more independent variables, or factors, have 
an effect on a set of two or more dependent variables 
 For example, you might wish to test the hypothesis that sex and 

ethnicity interact to influence  a set of job-related outcomes 
including attitudes toward co-workers, attitudes toward 
supervisors, feelings of belonging in the work environment, 
and identification with the corporate culture 

 As another example, you might want to test the hypothesis that 
three different methods of teaching writing result in significant 
differences in ratings of student creativity, student acquisition 
of grammar, and assessments of writing quality by an 
independent panel of judges 
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MANOVA 
 The one-way multivariate analysis of variance (one-way MANOVA) is 

used to determine whether there are any differences between 

independent groups on more than one continuous dependent 

variables. 

 Example:  

 To understand whether there were differences in students' short-

term and long-term recall of facts based on three different lengths 

of lecture (i.e., the two dependent variables are "short-term 

memory recall" and "long-term memory recall", whilst the 

independent variable is "lecture duration", which has four 

independent groups: "30 minutes", "60 minutes", "90 minutes" 

and "120 minutes").  
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Assumptions of MANOVA 
1. Multivariate normality 
All of the DVs must be distributed normally  
Any linear combination of the DVs must be distributed 

normally 
All subsets of the variables must have a multivariate normal 

distribution 
2.  Homogeneity of the covariance matrices  
In ANOVA we talked about the need for the variances of the 

dependent variable to be equal across levels of the 
independent variable 
 In MANOVA, the univariate requirement of equal variances 

has to hold for each one of the dependent variables  
3. Independence of observations 

 Subjects‘ scores on the dependent measures should not be 
influenced by or related to scores of other subjects in the 
condition or level  
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Example – MANOVA in SPSS 

 
The students at a higher secondary school come from three 

different primary schools. The school Principal wanted to know 

whether there were academic differences between the students 

from the three different primary schools.  

The principal randomly selected 20 students from School A, 20 

students from School B and 20 students from School C, and 

measured their academic performance as assessed by the 

marks they received in English and Maths exams. We have 

two dependent variables were "English score" and "Maths 

score", whilst the independent variable was "School", which 

consisted of three categories: "School A", "School B" and 

"School C". 

 440 
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 Key in the data 

 Click Analyze > General Linear 

Model > Multivariate. 

441 

Transfer the independent variable, School, into the Fixed 

Factor(s); and transfer the dependent variables, 

English_Score and Maths_Score, into the Dependent 

Variables: 
442 
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Transfer the independent variable, School, into the 

Horizontal Axis 

Click Add 

443 

Click Add. You will see that "School" has been added to the Plots 
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Click post hoc 

Transfer the independent 

variable, School, into the 

Post Hoc Tests for: and 

select the Tukey checkbox in 

the -Equal Variances 

Assumed- area 

445 
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• Select the Descriptive statistics, Estimates 

of effect size and Observed power 

checkboxes in the -Display- area. 

• Click continue and click OK 

Transfer the independent variable, 

"School", from the Factor(s) and Factor 

Interactions: into the Display Means for:  
447 

See the "Sig." value of .000, which means p < .0005. Therefore, we can conclude that this 

school's students academic performance was significantly dependent on which prior school they 

had attended (p < .0005). 448 
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 The prior schooling has a statistically significant 

effect on both English (F (2, 57) = 18.11; p < .0005; 

partial η2 = .39) and Maths scores (F (2, 57) = 14.30; 

p < .0005; partial η2 = .33).  

449 

 The mean scores for English were statistically significantly different between School 

A and School B (p < .0005), and School A and School C (p < .0005), but not 

between School B and School C (p = .897).  

 Mean maths scores were statistically significantly different between School A and 

School C (p < .0005), and School B and School C (p = .001), but not between 

School A and School B (p = .443).  
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Discriminant analysis 

using SPSS 

Discriminant Analysis 
 Discriminant analysis is used to determine 

which variables discriminate between two or 
more naturally occurring groups.  

 Discriminant analysis characterize the relationship 
between a set of IVs with a categorical DV with 
relatively few categories 
 It creates a linear combination of the IVs that best 

characterizes the differences among the groups 

 Predictive discriminant analysis focus on creating a rule 
to predict group membership 

 Descriptive DA studies the relationship between the DV 
and the IVs. 
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Discriminant Analysis 

For example, an educational researcher may want to 

investigate which variables discriminate between high 

school graduates who decide to 

(1) go to college,  

(2) attend a trade or professional school, or  

(3) seek no further training or education.  

For that purpose the researcher could collect data on 

numerous variables prior to students' graduation. After 

graduation, most students will naturally fall into one of the 

three categories. Discriminant Analysis could then be used 

to determine which variable(s) are the best predictors of 

students' subsequent educational choice.  
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Discriminant Analysis 

 For example, a medical researcher may record different 

variables relating to patients' backgrounds in order to 

learn which variables best predict whether a patient is 

likely to recover completely (group 1), partially (group 2), 

or not at all (group 3). 

 A biologist could record different characteristics of similar 

types (groups) of flowers, and then perform a 

discriminant function analysis to determine the set of 

characteristics that allows for the best discrimination 

between the types.  
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Discriminant Analysis 

 Possible applications: 

Whether a bank should offer a loan to a new 

customer? 

Which customer is likely to buy? 

 Identify patients who may be at high risk for 

problems after surgery 

455 

Promotional Campaigns 

 Identify groups based on their response to 
promotional campaigns 
 One group purchases a lot on promotion 

 Other does not 

 Identify characteristics that distinguish these two 
groups 

456 
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Discriminant Analysis 

 How does it work? 
 Assume the population of interest is composed of 

distinct populations 

 Assume the IVs follows multivariate normal 
distribution 

 DS seek a linear combination of the IVs that best 
separate the populations 
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Discriminat Analysis  

 For example 

 A borrower is looking for bank loan 

 There are two groups in customers (Good and Bad) bank will 

have 

 For good customers bank will give the loan 

 For bad customers extend the loan after collecting good 

collaterals and guarantee form from a reputed rich person  

 

 On what basis will we assign a new comer to the bank to 

borrow? 

458 



230 

Discriminant analysis 

 Computing the centroids is the main objective 

of discriminant analysis 

 We will use the customer satisfaction data file 

 There are two groups 

 If a new customer is to be assigned in either 

Islamic banking or conventional banking group 

how well it discriminates 

 What are the centroids? What is the function it 

forms? Let us test. 

459 

Discriminant analysis 
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Discriminant analysis 

461 

2 

4 
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Number of Variables in covariance matrix 

Covariances are equal for Islamic and conventional 

bank customers – not discriminating well (sig 

>0.05) 

Eigen value should be more than 1 

Canonical correlation should  

be more than 80% (poor) 

Model not discriminating well (sig > 0.05) 

464 
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Discriminant output - 3 

Standardised coefficients to rank the power of 

discrimination by variables 

Correlations between variables and expected 

variables created by function 

Unstandardised coefficients to find centroids for 

classification 

465 

Discriminant output - 4 

Centroids at means to classify 

the new comer 

54.2%  and 53.1% of customers only 

classified correctly  

54% classification correct - poor (95% and above is good classification) 
466 
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Discriminant analysis (Interpretation) 

•1. Box‟s M – Compares the covariance matrices 

Sig (p value) should be less than 0.05 to confirm 

that covariance matrices are different 

•2. The Eigen Value explains the power of 

discrimination. It should be more than 1 

•3. The canonical correlation should be more than 

80% 

4.Wilk‟s Lambda is like 1-R2 . The Chi – square 

should be significant to prove that the function 

discriminates well 
467 

Discriminant analysis (Interpretation) 

•5. The Standardized canonical discriminant function 

coefficients can be used to rank the variables from best 

discriminator to worst discriminator  

•6. The structure matrix gives the correlations between 

variables and expected variables produced by the 

discriminant function.  

•7. The unstandardized coefficients form the function and 

also useful to find centroids 

•8. Centroids average will help in classifying the new 

comers 
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Cluster analysis using 

SPSS 

Cluster Analysis 

 Cluster analysis is an exploratory data 
analysis technique design to reveal groups 

 How? 

By distance: close together observations 
should be in the same group, and 
observations in the groups should be far apart 

 Applications: 

Plants and animals into ecological groups 

Companies for product usage 
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Cluster Analysis 
 Two types of method 

 Hierarchical: requires observations to remain 

together once they have joint in a cluster 

 Complete linkage 

 Between groups average linkage 

 Ward‘s method 

 It requires the number of clusters to be specified in 

advance, and the initial number chosen may split natural 

groupings or combine two or more groups that are 

rather different from each other. 

 Nonhierarchical: no such requirement 

 Research must pick a number of clusters to run (K-means 

algorithm) 
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Cluster Analysis 

 Recommendations: 

For relative small samples, use hierarchical 
(less than a few hundred) 

For large samples, use K-means 
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Hierarchical Cluster analysis – Example - 

Dogs species weight and height 
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Dissimilarity matrix 

 The more value more the dissimilarty 

 If the value is low the organisms are very 

close to each other. 
477 
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K means cluster analysis 
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Age and reading ability variable is not significant to make the cluster. Short 

term memory span and IQ is significantly good for having cluster formation. 
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 Cluster 

membership 

 How much 

difference 

from 

cluster 

center 

487 

Exploratory factor analysis 

(Principal Components 

Analysis) using SPSS 
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Factor analysis or Principal 

components analysis 
 Principal components analysis is a variable-reduction 

technique. Data reduction technique 

 Its aim is to reduce a larger set of variables into a smaller 

set of 'artificial' variables, called 'principal components', 
 Let's say, we have 500 questions on a survey we designed to measure 

persistence. We want to reduce the number of questions so that it does not 

take someone 3 hours to complete the survey.  

 It would be appropriate to use PCA to reduce the number of questions by 

identifying and removing redundant questions. For instance, if question 122 

and question 356 are virtually identical (i.e. they ask the exact same thing 

but in different ways), then one of them is not necessary.  

 The PCA process allows us to reduce the number of questions or variables 

down to their PRINCIPAL COMPONENTS. 

489 

Assumptions 
 Assumption #1: You have multiple variables that should 

be measured at the continuous level or ordinal variables 

 Assumption #2: There needs to be a linear relationship 

between all variables. The reason for this assumption is 

that a PCA is based on Pearson correlation coefficients, 

and as such, there needs to be a linear relationship 

between the variables. 

 Assumption #3: You should have sampling adequacy, 

which simply means that for PCA to produce a reliable 

result, large enough sample sizes are required. 

 Assumption #4: There should be no significant outliers. 
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Example 
 A company director wanted to hire another employee for his company 

and was looking for someone who would display high levels of 

motivation, dependability, enthusiasm and commitment  

 In order to select candidates for interview, he prepared a questionnaire 

consisting of 25 questions that he believed might answer whether he 

had the correct candidates. He administered this questionnaire to 315 

potential candidates. The questions were phrased such that these 

qualities should be represented in the questions.  

 

 The director wanted to determine a score for each candidate so that 

these scores could be used to grade the potential recruits. 
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Example: 

Wechsler Intelligence Scale for Children  

  The most common assessment instrument used by 

psychologists is the Wechsler Intelligence Scale for 

Children. 

 The test is divided into two sections with each section 

containing a number of subtests. 

 
Verbal 

Scale      

Performance 

Scale      

Information  Picture Compilation  

Similarities  Coding           

Arithmetic  Picture Arrangement   

Vocabulary  Block Design   

Comprehensi

on  
Object Assembly  

  

Verbal Scale      Performance Scale      

Digit Span  Symbol Search 

  Mazes  
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Click Analyze > Dimension Reduction > Factor...  

493 

Transfer all the variables you want 

included in the analysis, into the 

Variables box. 

Click Initial solution in the -Statistics- 

area), also check Coefficients, KMO and 

Bartlett's test of sphericity.  
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The Descriptive Statistics table simply reports the mean, standard deviation, and 

number of cases for each variable included in the analysis. 
499 

The Correlation Matrix is the correlation matrix for the variables included. 

Kaiser-Meyer-Olking (KMO) statistic should be greater than 0.600 and the 

Bartlett's test should be significant (p < .05). KMO is used for assessing sampling 

adequacy and evaluates the correlations to determine if the data are likely to 

CORRELATE on components 
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A communality (h²) is the sum of the squared 

component loadings and it represents the 

amount of variance in that variable 

accounted for by all the components 

501 

 The variance explained by each component as well as the cumulative variance 

explained by all components.  Variance explained means the amount of variance in 

the total collection of variables/items which is explained by the component(s).  

 For instance, component 3 explains 10.492% of the variance in the items. 

  We could also say, 58.062% of the variance in our items was explained by the 3 

extracted components.  
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eigenvalues greater than 1 was generally accepted 

503 

Rotated Component Matrix shows you the factor loadings for each variable.  

Based on these factor loadings, the factors represent: --The first 5 subtests loaded 

strongly on Factor 1, which I‟ll call “Verbal IQ” --Picture Completion through 

Object Assembly all loaded strongly on Factor 2, which I‟ll “Performance IQ” --

Coding loaded strongly on Factor 3. 
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Bootstrap using SPSS 

Bootstrapping 

 
 Bootstrapping is a statistical technique that falls under the broader 

heading of resampling. Bootstrapping can be used in the estimation of 

nearly any statistic 

 One goal of inferential statistics is to determine the value of a 

parameter of a population. 

 It is typically too expensive or even impossible to measure this directly. 

So we use statistical sampling. We sample a population, measure a 

statistic of this sample, and then use this statistic to say something 

about the corresponding parameter of the population. 

 

 For example, in a chocolate factory, we might want to guarantee that 

candy bars have a particular mean weight. It‘s not feasible to weigh 

every candy bar that is produced, so we use sampling techniques to 

randomly choose 100 candy bars. We calculate the mean of these 100 

candy bars, and say that the population mean falls within a margin of 

error from what the mean of our sample is. 
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http://statistics.about.com/od/Descriptive-Statistics/a/Differences-In-Descriptive-And-Inferential-Statistics.htm
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What is a Bootstrap 

 A method of Resampling: creating many 

samples from a single sample 

 Generally, resampling is done with 

replacement 

 Used to develop a sampling distribution of 

statistics such as mean, median, 

proportion, others. 
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Bootstrap confidence interval 

 Bootstrap confidence intervals provide a 

way of quantifying the uncertainties in the 

inferences that can be drawn from a 

sample of data. 

 The idea is to use a simulation, based on 

the actual data, to estimate the likely 

extent of sampling error.  
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Advantages and Disadvantages 

 Advantages: 
 Avoids the costs of taking new samples (Estimate a sampling 

distribution when only one sample is available) 

 Checking parametric assumptions 

 Used when parametric assumptions cannot be made or are very 
complicated 

 Estimation of variance in quantiles 

 

 Disadvantages: 
 Relies on a representative sample 

 Variability due to finite replications (Monte Carlo) 
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